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Notice Every effort was made to ensure that the information in this document 
was accurate at the time of printing. However, information is subject to 
change without notice, and JDSU reserves the right to provide an 
addendum to this document with information not available at the time that 
this document was created.

Copyright © Copyright 2008 JDSU, LLC. All rights reserved. JDSU, Enabling 
Broadband and Optical Innovation, and its logo are trademarks of JDSU, 
LLC. All other trademarks and registered trademarks are the property of 
their respective owners. No part of this guide may be reproduced or 
transmitted electronically or otherwise without written permission of the 
publisher.

Trademarks JDSU and MTS/T-BERD 4000 are trademarks or registered trademarks 
of JDSU in the United States and/or other countries.

Microsoft, Windows, Windows CE, Windows NT, and Microsoft Internet 
Explorer are either trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries.

Netscape Navigator is a trademark or registered trademark  of Netscape 
Communications Corporation in the United States and other countries.

Ordering
information

This guide is a product of JDSU's Technical Information Development 
Department, issued as part of the User Manual.

WEEE Directive
Compliance

JDSU has established processes in compliance with the Waste Electrical 
and Electronic Equipment (WEEE) Directive, 2002/96/EC.

This product should not be disposed of as unsorted municipal waste and 
should be collected separately and disposed of according to your 
national regulations. In the European Union, all equipment purchased 
from JDSU after 2005-08-13 can be returned for disposal at the end of 
its useful life. JDSU will ensure that all waste equipment returned is 
reused, recycled, or disposed of in an environmentally friendly manner, 
and in compliance with all applicable national and international waste 
legislation.

It is the responsibility of the equipment owner to return the equipment to 
JDSU for appropriate disposal. If the equipment was imported by a 
reseller whose name or logo is marked on the equipment, then the owner 
should return the equipment directly to the reseller.
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Instructions for returning waste equipment to JDSU can be found in the 
Environmental section of JDSU’s web site at www.jdsu.com. If you have 
questions concerning disposal of your equipment, contact JDSU’s 
WEEE Program Management team at WEEE.EMEA@jdsu.com.
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About This Guide
The 4000 Base-Unit of JDSU provides a portable, modular platform 
designed for the construction, validation and maintenance of FTTx 
networks.

The topics discussed in this chapter are as follows:

– “Purpose and scope” on page xiv

– “Assumptions” on page xiv

– “Technical assistance” on page xiv

– “Recycling Information” on page xv

– “Conventions” on page xv
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Purpose and scope
Purpose and scope
The purpose of this guide is to help you successfully use the 4000 Base-
Unit features and capabilities. This guide includes task-based instruc-
tions that describe how to install, configure, use, and troubleshoot the 
4000 Base-Unit. 

Additionally, this guide provides a complete description of JDSU’s 
warranty, services, and repair information, including terms and condi-
tions of the licensing agreement.

Assumptions
This guide is intended for novice, intermediate, and experienced users 
who want to use the 4000 Base-Unit effectively and efficiently. We are 
assuming that you have basic computer and mouse/track ball experience 
and are familiar with basic telecommunication concepts and terminology.

Technical assistance 
If you need assistance or have questions related to the use of this 
product, call or e-mail JDSU’s Technical Assistance Center for customer 
support.

Table 1 Technical assistance centers

Region Phone Number

Americas
Telecom Products

866 228 3762
World Wide: 301 353 1550

tac@jdsu.com

Europe, Africa, and 
Mid-East

+49 (0) 7121 86 1345
(Europe)

hotline.europe@jdsu.com

+33 (0) 1 30 81 50 60
(JDSU France)

support.france@jdsu.com

Asia and the Pacific
Southeast Asia, Aus-
tralia, and New Zea-
land

+852 2892 0990
(Hong Kong)

+86 10 6833 7477
(Beijing-China)

All others 866 228 3762 tac@jdsu.com
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About This Guide
Recycling Information
During off-hours, you can request assistance by doing one of the 
following:

– leave a voice mail message at the Technical Assistance number in 
your region

– e-mail North American Technical Assistance Center, tac@jdsu.com, 
or European Technical Assistance Center, support.uk@jdsu.com

– submit your question using our online Technical Assistance Request 
form at www.jdsu.com.

Recycling Information
JDSU recommends that customers dispose of their instruments and 
peripherals in an environnmentally sound manner. Potential methods 
include reuse of parts or whole products and recycling of products 
components, and/or materials.

Waste Electrical and electronic Equipment (WEEE) Directive

In the European Union, this label indicates that this product should not 
be disposed of with household waste. Il should be deposited at an appro-
priate facility to enable recovery and recycling.

Conventions
This guide uses naming conventions and symbols, as described in the 
following tables.

Table 2 Typographical conventions

Description Example

User interface actions appear in 
this typeface.

On the Status bar, click Start.

Buttons or switches that you 
press on a unit appear in this 
TYPEFACE.

Press the ON switch

Code and output messages 
appear in this typeface.

All results okay
User Manual 770000002/04 xv

mailto:tac@jdsu.com
mailto:support.uk@jdsu.com
http://www.jdsu.com


About This Guide
Conventions
Table 4 Symbol conventions

Text you must type exactly as 
shown appears in this type-
face.

Type: a:\set.exe in the dia-
log box

Variables appear in this type-
face.

Type the new hostname.

Book references appear in this 
typeface. 

Refer to Newton’s Telecom 
Dictionary

A vertical bar | means “or”: only 
one option can appear in a sin-
gle command.

platform [a|b|e]

Square brackets [ ] indicate an 
optional argument.

login [platform name]

Slanted brackets < > group 
required arguments.

<password>

Table 3 Keyboard and menu conventions 

Description Example

A plus sign +  indicates simulta-
neous keystrokes.

Press Ctrl+s

A comma indicates consecutive 
key strokes.

Press Alt+f,s

A slanted bracket indicates 
choosing a submenu from 
menu.

On the menu bar, click 
Start > Program Files.

Table 2 Typographical conventions (Continued)

Description Example

This symbol represents a general hazard.
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Table 5 Safety definitions

This symbol represents a risk of electrical shock.

NOTE

This symbol represents a Note indicating related information or tip.

This symbol, located on the equipment or its packaging 
indicates that the equipment must not be disposed of in a land-
fill site or as municipal waste, and should be disposed of 
according to your national regulations.

WARNING

Indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury.

CAUTION

Indicates a potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury.
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Chapter 1 Introducing the 4000 Base 
Unit
1

The JDSU 4000 Base Unit is a portable, modular platform designed for 
the construction, commissioning and maintenance of FTTx networks. 

The topics discussed in this chapter are as follows:

– “Terminology used in this manual” on page 2

– “Laser safety” on page 2

– “AC/DC and battery important safety instructions” on page 3

– “Architecture” on page 4

– “User interface” on page 5

– “Technology” on page 6

– “Mechanical strength” on page 6

– “Software” on page 6

– “Measurements” on page 7
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Terminology used in this manual
Terminology used in this manual
To designate the modules making up the 4000 Base Unit, the following 
conventions have been adopted:

– User Interface Module designates the module comprising the 
screen and controls.

– Battery designates the compartment where the 
battery is set.

– Module designates, for example, the OTDR.

Laser safety
The provisions contained in two standards define the safety procedures 
to be observed both by users and by manufacturers when utilizing laser 
products:

– EN 60825-1: 2001 - Safety of laser products – Part 1: Classification 
of products, requirements and user guidelines. 

– FDA 21 CFR § 1040.10 - Performance standards for light-emitting 
products - Laser products.

Due to the range of possible wavelengths, power values and injection 
characteristics of a laser beam, the risks inherent in its usage vary. The 
laser classes form groups representing different safety thresholds.

Fig. 1 Designations of sub-assemblies of the 4000 Base 
Unit

User Interface 
Module

Module
Battery 
compartment
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AC/DC and battery important safety instructions
Laser classes Standards EN 60825-1, Edition 1.2, 2001-08 and FDA21CFR§1040.10: 

– VFL option: Class 2.

Warning labels
for the laser

classes

Due to the reduced dimensions of the optical modules, it is not possible 
to attach the required warning labels to them. In line with the provisions 
of Article 5.1 of the EN 60825-1 standard, the laser class identification 
labels are shown below:

The user must take the necessary precautions concerning the optical 
output of the instrument and follow the manufacturer’s instructions.

AC/DC and battery important safety instructions

The 4000 Base Unit is supplied with a Lithium Ion rechargeable battery.

Batteries supplied by JDSU incorporate protection means.

Reference 
standard

EN 60825-1, Edition 1.2,
2001- 08

FDA21CFR§1040.10

Class 1

Class 2

CLASS 1
LASER PRODUCT

LASER RADIATION
DO NOT STARE INTO BEAM
CLASS 2 LASER PRODUCT

LASER RADIATION - DO 
NOT STARE INTO BEAM 

CLASS II LASER PRODUCT

CAUTION

Measurements on optical fibers are difficult to execute and the preci-
sion of the results obtained depends largely on the precautions taken 
by the user.

In conformance with the recommendations of standard EN 61010, the 
instrument should be operated within the manufacturer’s guidelines. 
Failure to do so may compromise the protection offered by the instru-
ments design.

Do not use any mains adaptor or battery other than those supplied 
with the instrument, or supplied by JDSU as an option for this instru-
ment.
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Architecture
If another adapter or battery is used, it may damage the 4000 Base Unit 
itself. Using the 4000 Base Unit with batteries other than those supplied 
by the manufacturer of the 4000 Base Unit may entail risks of fire or 
explosion. 

– The battery may explode, leak or catch fire:
- if it is exposed to high temperature or fire
- if it is opened or dismantled.

Other basic safety precautions are as follows:

– Do not use AC/Adapter/Charger outdoors or in wet or damp loca-
tions

– Connect the AC/Adapter/Charger to the correct mains voltage, as 
indicated on the ratings label.

– This product is intended to be used with a 3-wire grounding-type 
plug (a plug that has a grounding pin). This safety feature is vital to 
the safe operation of the instrument. Do not defeat the purpose of 
the grounding-type by modifying the plug or using an adapter.

– Do not allow anything to rest on the power cord, and do not locate 
the product where people can walk on the power cord.

– Avoid using this product during an electrical storm. There may be a 
remote risk of electric chock from lightning.

– Do not use this product in the vicinity of a gas leak or in any explo-
sive environment.

– Do not attempt to service this product yourself, as opening or 
removing covers may expose you to dangerous, high voltage points 
and other hazards. Contact qualified service personnel for all 
service.

The 4000 Base Unit is equipped with a main supply for optical configura-
tions

Architecture
The architecture of the 4000 Base Unit is based on the superimposition 
of modules. This structure adapts to current applications in fiber optics 
and will adapt to future applications. 

By the addition of modules, a lightweight battery-operated field instru-
ment suitable for optical network maintenance can be converted into a 
complete apparatus with a high-level of performance and functions for 
the installation and upgrading of FTTx networks.
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User interface
Modules are easily interchangeable in the field, reducing the number of 
instruments to be carried.

Whatever its configuration,  the Platform 4000 has a user interface 
module with screen and controls and a battery compartment.

Maximum configuration of the 4000 Base Unit

In addition to the user interface module, the 4000 Base Unit can include  
one big module, one small module and the other one empty, or two small 
modules.

User interface
The topmost element of the 4000 Base Unit constitutes the user inter-
face. 

It is equipped with:

Fig. 2 Possible configurations of the 4000 Base Unit

Base Unit only Base Unit with 
1 small module

Base Unit with 2 
small modules

Base Unit with 
1 big module
User Manual 770000002/04 5



Chapter 1 Introducing the 4000 Base Unit
Technology
– a 7 inch TFT color screen, high visibility (optimized for outdoor use), 
which can be touchscreen on option

– hard keys or tactile keys (if the touchscreen option is available)

– numerous functions such as Fault Locator VFL (Visual Fault Loca-
tion),  power meter, optical microscope, bluetooth etc.

– remote front panel function etc.

The particularly simple user interface means familiarity with the instru-
ment is quickly attained. This interface remains the same, irrespective of 
the options and modules with which the instrument may be equipped. 

An external keyboard and a mouse (on option) facilitate data input.

Technology
The 4000 Base Unit employs multi-tasking for the simultaneous perfor-
mance of several operations (such as acquisition, modification of param-
eters, trace analysis, printing) and several functions (for example  
powermeter, OTDR  measurements).

The measurement results can be stored in the internal memory (512Mb), 
or on the following options:

– internal memory extension (1 Gbyte)

– plug-in media (USB memory stick)

 Mechanical strength
Although it is extremely light, the housing of the 4000 Base Unit can 
resist harsh environmental conditions:

– its rubber protectors give it high shock resistance

– it resists water splashes.

The modules are very simple to install, requiring only a screwdriver.

Software
The software can be easily updated from the harddisk of the PC,from 
Ethernet, or from a USB stick .
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Measurements
Measurements
The 4000 Base Unit can be used to test FTTx networks:

– during the phase of design and production of equipment

– during the phase of installation and validation of such equipment in 
a network

– during the phase of network maintenance
User Manual 770000002/04 7
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Chapter 2 Starting up
2

This chapter explains the operations to be carried out before using the 
4000 Platform.

The topics discussed in this chapter are as follows:

– “Unpacking the instrument” on page 10

– “Assembling the component parts of the 4000 Platform” on page 10

– “Choosing the position of the instrument on the work surface” on 
page 12

– “Battery management” on page 14

– “Switching the 4000 Platform on and off” on page 18

– “Presentation page of the 4000 Platform” on page 20

– “Troubleshooting” on page 21
User Manual 770000002/04 9
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Unpacking the instrument
Unpacking the instrument
Remove the 4000 Platform and its accessories from the packing case. 
Check that the modules and accessories ordered are all there.

If any part is missing or damaged please contact your local JDSU agent.

The 4000 Platform is delivered with the following accessories:

– a USB memory stick, countaining the User Manuals for 4000 Plat-
form, and modules. 

– a battery which must be charged before use.

– a mains adapter used for mains operation of the instrument and 
battery charging 

– a glove for the 4000 Platform (option) 

– a soft carrying case for the 4000 Platform (option)

– a large soft case for one big module or two smalls, according to the 
module(s) ordered

– a small soft case for one small module,if one small module has been 
ordered

Assembling the component parts of the 4000 Platform
– Assembly starts from the Interface module, which is placed face 

down on the work surface.

– The module(s) must then be fixed in place one after the other, using 
a screwdriver.

Fitting and
removing a

module

To fit a module

– Turn the instrument face down on the work surface.

– Set the two notches on the module part (1a) into the two holes 
provided for that purpose on the Base (1b).

The 4000 Platform must be switched off, and if it is operating on the 
mains, its supply cable must be unplugged.
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Assembling the component parts of the 4000 Platform
– Make flush the 2 connections (2a & 2b), on module and base.

– Once positioned, fix the module to the base screwing the 2 screws 
fixing the receptacle.

– Repeat the same procedure for the following module if 2 small 
modules are to be used.

Removing a module

1 Unscrew the two captive fixing screws of the module completely (up 
to the stop).

2 Remove the two slots of the module from their housing onto the 
base.

3 Carefully slide the module out of its slot.

Installing the
backplate

The backplate, delivered on option, can be installed when no module is 
set onto the 4000 Platform.

Fig. 3 Fixing the module to the base

Captive screws fixing the module(s)

1a1b

2b
2a

1a

2a
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Choosing the position of the instrument on the work surface
Installing the backplate

1 Turn  the Platform face down, on the work surface.

2 Set the two notches (1a) of the backplate into the two holes of the 
base-unit (1b) 

3 Once positioned, fix the backplate to the base, screwing the five 
screws fixing the backplate.

Removing the backplate

1 Unscrew the five fixing screws of the backplate completely (up to the 
stop).

2 Remove the two notches (1a) of the backplate from their housing 
onto the base.

3 Carefully slide the backplate out of its slot.

Choosing the position of the instrument on the work surface
Depending on the conditions of use of the 4000 Platform, the instrument 
may be placed on a flat surface or held in the hand.

When used on a work surface, the 4000 Platform should be supported 
on its stand, which can be set in either of two positions, depending on 
whether the user is standing or sitting.

To change the stand from “seated user” position to “standing user” posi-
tion,pull the stand towards you to unlock it from its housing.

Fig. 4 Fixing the backplate option onto the 4000 Base-Unit

1b 1a

Fixing screwsLocation of fixing screws
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Choosing the position of the instrument on the work surface
Setting the 4000
Platform into

the glove

The glove for the 4000 Platform is furnished on option with the instru-
ment.

This glove has been desgined to fit to the equipment, and to easily get 
access to all the commands of the product (interface, modules, connec-
tors).

To set the 4000 Platform in the glove, take care of the sense of insertion: 
the screen must face the front of the glove.

Refer to Figure 6.

Once in the glove, the 4000 Platform can be set to the «standing» posi-
tion, using the stay on the back of the glove. 

Fig. 5 Stay in positions for seated user and standing user

Stand

The stand can be used only when one big module or two smalls 
is / are set under the base.
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Battery management
Battery management1

The battery supplied with the 4000 Platform must be fully charged before 
use. 

A Lithium Ion type battery, 6 cells or 9 cells, is installed in the battery 
compartment.

Charging the
battery

Connecting the mains adapter

– At the top of the 4000 Platform, lift up the power supply socket 
protector and plug in the mains adapter. 

– Connect the adapter to the mains. The On indicator lamp starts to 
blink in green.

Fig. 6 Plaform View in the glove

1.if the 4000 Platform is equipped with a battery.

Use only the mains adapter supplied with the 4000 Platform. The 
adapter for some other electronic device may appear to be identical, 
but entails a risk of damage to the 4000 Platform.
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Charging 

If the instrument is fitted with a battery, on connection to the mains:

– if the user does not press ON, the battery will start the charge. In this 
case, the Charge indicator will be lit in red. 

– when the user presses the ON key, the instrument starts up and the 
battery will charge during use (Charge indicator in solid red).

Once the battery is fully charged, the Charge indicator lamp is solid 
green.

When the Charge indicator is blinking red, this mean the power supply is 
not compatible with the battery used. Charge is disabled.

Voltage must be superior to 14V to correctly charge the 9 cells battery 
(11V).

Only the 6 cells battery can be charged using the cigarette lighter adapter 
(provided on option). When this adapter is used with a 9 cells battery, the 
equipment can be used but the battery will not be charged (except if the 
vehicle is started). 

Battery charging time

If the battery is completely discharged, the time taken to recharge is:

– approximately 5.5 hours, if the apparatus is not in use (Charge indi-
cator solid red)

– about 12 hours if the instrument is used during charging (Charge 
indicator lit in solid red).

Battery endurance

A 6 cells battery is only guaranteed to deliver 20W and a 9 cells battery  
30W, at ambient temperature. During discharge, battery increases its 
temperature.
Above 20W/30W at ambient temperature, the message Battery too 
hot, please turn power off may be displayed on the screen, 
inviting the user to shut off the equipment.

The user may or may not shutt off the product but the product may shut 
off later by itself, without warning.

It is essential to wait until charging is complete to ensure maximum 
independent operating time, which may otherwise be considerably 
reduced.
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Battery management
The follonwng specifications are given for a MTS 4000 with one LiIon 
Battery, at 25°C, at full battery capacity (6.6 A.h), with one RLM OTDR 
module and without any options:

Charge and On indicators

– On blinking green: the instrument is switched off but connected to 
an external power source.

– On solid green: the instrument is operating, either on batteries or an 
external power source.

– Charge solid red: the instrument is connected to an external power 
source and the battery is on charge.

– Charge solid green: the instrument is connected to an external 
power source and the battery is fully charged.

– Charge blinking red: the supply is not compatible with the battery 
used.

Battery charge level display

When the battery is installed in the instrument, its charge level is 
displayed in the top right-hand corner of the screen and also as a charge 
percentage. Example: .

– When the battery charge level drops below 10%, a warning is 
displayed next to the  icon. Example:  When the level 
becomes too low, the instrument switches off automatically after 
saving the current configuration.

Endurance

Conditions of use
6 cells battery 
(7400 mV)

9 cells battery 
(11100 mV)

According to Telcordia GR-196-CORE recommenda-
tion:
Normal conditons, with normal backlight, 3 acquisi-
tion of 30 seconds per quarter of hour, auto off

up to 7 hours up to 11 hours.

Under continuous acquisition, with high screen back-
light 

Up to 3h15 Up to 5h15

It is essential to wait until charging is complete for maximum battery 
endurance, otherwise this may be considerably reduced and the level 
of charge may not be correctly displayed.
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Battery management
In the table below is a summary of the battery icon according to the 
charge level:

Access to the
battery

– Switch off the instrument and disconnect the mains supply.

– On the left side of the equipement, loosen the captive screws (a) at 
both sides using a Philips head screwdriver.

– Remove the battery door, pulling with the help of the screws

– Pull the battery to disconnect it from the base, taking care not to 
damage the connector into which it is plugged.

When putting the battery back into its seating, make sure that its 
connector engages correctly with the one of the base. 

Table 1 Color of the battery Icon according to charge level

Icon Charge level

From 100% to 70%

From 70% to 40%

From 40% to 10%

From 10% to 0%

Fig. 7 Battery seatings

 screws (a)
 Battery
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Switching the 4000 Platform on and off
Safety
recommendatio

ns

The Lithium Ion battery is designed for maximum safety. In particular, 
each cell is provided with a safety valve to prevent excessive internal 
pressure in the event of overcharging or exposure to very high tempera-
tures.

If you do not intend to use the platform for several weeks, it is advisable 
to remove the battery in order to prolong its useful life, and to recharge it 
fully before using it again.

In case of communication problems with the battery, informed to the user, 
the battery charging information is no more actualized.
Restart the equipment to restore the communication with battery.

Switching the 4000 Platform on and off
The mains adapter is used not only for charging the battery (if the battery  
is installed), but also for operating the 4000 Platform on the mains, if a 
mains socket is at hand, to save the battery.

Switching on
the 4000
Platform

Switching on using the battery

– Press the ON/OFF key.The On indicator pass from blinking to solid 
green. 

The JDSU logo appears on the screen briefly, then an autotest is 
carried out, the software is installed (this just takes a few seconds), 
then the screen goes dark for about three seconds. 

Then, the Help screen appears  (see "Presentation page of the 
4000 Platform" page 20).

The equipment is ready to be used once the Home page is 
displayed, or once the result page of the function selected before 
the Platform has been switched off and restart is displayed..

Make sure that the connector of the battery engages properly with the 
one of the base. Tighten the screws, as securing the battery by the 
connector alone will not ensure uninterrupted operation.

Use only the battery supplied with the 4000 Platform. Batteries sup-
plied with other electronic devices may appear to be identical, but 
entail a risk of damage to the 4000 Platform.
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Switching the 4000 Platform on and off
Mains operation

If the instrument is to operate on the mains:

– lift the protective cover over the power supply socket on the upper 
part of the 4000 Platform (upper left side, with the icon ) and 
plug in the mains adapter.

– press the ON key (if this is not done, and the instrument is equipped 
with a battery, it will switch over to charging of the battery).

The JDSU logo shows briefly and is followed by an autotest,  the 
software is installed (this just takes a few seconds), then the screen 
goes dark for about three seconds. 

Then, the Help screen appears.

Finally, the equipment is ready to be used once the Home page is 
displayed, or once the result page of the function selected before 
the Platform has been switched off and restart is displayed.

Switching off
the 4000
Platform

While the 4000 Platform is operating, press the ON/OFF button to switch 
it off.

NOTE

It is possible to switch over from battery to mains operation, or vice 
versa, without loss of data.

The module cannnot be swapped when the unit is ON or AC 
powered

In the event of an unexpected mains power cut, if there is no battery, 
the current results and configuration will not be saved. Next time the 
instrument is switched on, it will return to its initial configuration.

Disconnect the jack connector of the AC/DC power supply 
before disconnecting the AC/DC mains

NOTE

When the instrument is switched off using the ON/OFF button, current 
results and configuration are saved. Next time the ON/OFF key is 
pressed, they are recalled.
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Presentation page of the 4000 Platform
Reset

If the 4000 Platform freezes, prolonged pressure (about 4 s.) on the ON/
OFF key will reset the instrument.

Presentation page of the 4000 Platform
The presentation page of the instrument is called up by pressing the 
HOME button, followed by Help. It also appears when the instrument is 
switched on.

This page shows:

1 the version of the softwares installed in the instrument, 

2 the base options; base reference, Power Meter, Bluetooth, touch-
screen, extension memory, battery reference...and the date of cali-
bration for concerned options. The options set into the base are 
marked with a green tick. 

3 the modules installed (including serial number and date of last cali-
bration).

NOTE

The first module in the page corresponds to the module on the left 
side of the Platform, when you face screen.

Fig. 8 Example of presentation screen
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Troubleshooting
The Software Options key allows to reach a screen in which the soft-
ware options can be visualized (ask your local agent JDSU to get infor-
mation about softwares options avaialble).

The Services Data key allows to display information about the services 
available: CPU, memory, hardware revision, screen reference, pack-
ages...

The Patents key allows to display the number of the patents according 
to the configuration of the 4000 Platform of client.

Troubleshooting

Troubleshooting Solution

Nothing happens when the 
ON/OFF key is pressed.

Make sure that the battery is pres-
ent or the mains adapter is prop-
erly connected.

You are using the 4000 Plat-
form in the ordinary way when 
it suddenly switches off.

The parameters of the instrument 
may have been set so that it 
switches off automatically after a 
predefined time of inactivity to 
save the battery. Work in progress 
is first saved in the memory. 
See ."Screen saver" page 50
Otherwise, check the battery 
charge level.

The battery refuses to charge 
(the Charge indicator does 
not go on when the instrument 
is connected to the mains and 
is not operating).

There is no battery in the instru-
ment.
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Troubleshooting
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Chapter 3 Controls of the 4000 Platform
3

This chapter describes the controls of the 4000 Platform.

The topics discussed in this chapter are as follows:

– “Control interface” on page 24

– “Using an external keyboard, mouse and touchscreen (options)” on 
page 29

– “Editing” on page 31

– “Accessing the 4000 Platform from a PC” on page 35

– “Connectors” on page 41

The 4000 Platform is a multi-tasking instrument: the user can simulta-
neously carry out an acquisition, modify the configuration parameters, 
print out results and access the directory of the internal memory. 
In some cases, it is even possible to perform several measurement 
operations at the same time, but only the result of the function 
selected can be displayed.
User Manual 770000002/04 23



Chapter 3 Controls of the 4000 Platform
Control interface
Control interface
The Interface module of the 4000 Platform embodies the controls and 
display needed for measurement analysis:

– the display screen, with the associated menu keys on the right.

– the ON/OFF button and the operating & battery charging indicators.

– the general control buttons: CANCEL / FILE / SETUP/ HOME / 
RESULTS

– the measurement control key:START/STOP

– the Test indicator (lit during a measurement)

– direction keys for scrolling through the menus

– a numeric keypad on the left

– the validation key ENTER.

– the key AUTO which calls up the Macro function

– the SHIFT key  to use the shortcuts .

 + 3: rise luminosity /  + 6: decrease luminosity 

 + 9: rise sound /  + # : decrease sound

 + HOME: full scale (in trace display mode)

Fig. 9 Controls of the Interface module

Menu keys TFT color screen

ON 
OFF

Charge 
and On 
indicators

CANCEL

FILE

SETUP

RESULTS

Micro

START/
STOP

Testing indicator (Test in progress)

Direction 
keys 
(Selection)

HOME

AUTO

ENTER

Micro

Numeric 
keypad

SHIFT

NOTE

The Print function is available by pushing simultaneously the left and 
right direction keys.
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Control interface
TFT display
screen

The 4000 Platform has a large, 7 inch TFT color screen, with a resolution 
of 800 x 480, back-lit:

– either a high visibility TFT screen, for hight visibility outdoors and 
indoors.

– or the high visibility screen supplied may also be a touch screen 
(option).

The different zones of the screen

The display is divided into 3 zones:

1 the central zone, displaying the configuration or the results of 
measurements.

2 at the top, in the status bar, in the form of icons:

a different icon according to the type of application and / or 
the name of this function

if visual fault location (VFL) is activated

if data saving is in progress

if the VNC function is used

if a battery is set in the Platform, the icon and the battery 
charge level (see "Battery charge level display" page 16).

if a USB stick is connected

if a printing process is in progress

if the Web Browser application is active

if the PDF viewer is activated

if the text editor application is active

if the calculator application is active

if the Mail application is active

if the Contact application is active

if the Calendar application is active

if the VNC Viewer application is active

if the Ethernet connection is established (  if it is cut)
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Control interface
– current date and time.

3 at the right side, rigid function keys (or tactile on option). 

Control buttons The buttons below the screen provide the following functions:

ON OFF

Main on/off switch

HOME

This button gives access to:

– selection of the different measurement or base functions

– the configuration menus of the instrument (choice of module(s) 
used), When the instrument is switched off, its configuration is 
stored in the memory, as are the measurement results.

– the configuration menus of the system (screen, date, language, 
print-out, etc.).Once you have pressed the System Settings key, 
you can select:

– the display parameters: screen illumination, automatic shut-
down.

– the parameters specific to the country of use: date, time, format 
of date/time, language.

– the input/output parameters: optical switch, Ethernet, e-mail 
configuration.

– the audio parameters (Headset / Hands-free function)

– the initialization of automatic shutdown of the instrument.

For a complete description, see "System set-up" page 43.

SETUP

This button calls up the measurement configuration menu. This menu 
depends on the function in use.

RESULTS

This button calls up the results page (e.g. with OTDR module: reflectom-
etry trace, results and table of results) and is used to analyze results.

FILE

NOTE

The configuration menus can be displayed, and modified if required 
during acquisition or measurement.
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Control interface
This button calls up the file and directory management menu.

It allows to:

– to choose the storage medium: internal memory, USB memory key, 
extended internal memory; file name and format; information 
relating to the data stored in the file.

– to store files or retrieve them for selection, copying or deletion; with 
facilities for classifying them in directories and sub-directories.

START/STOP

Starts and stops the measurement. 

AUTO

This button allows to launch the Script function. This can only be acti-
vated if a module is set onto the 4000 Platform.

CANCEL

This button allows to deselect a function on the Home page, or to quit the 
edition/numeric keypad without validating the modifications.

Numeric
keypad on the
4000 Platform

The numeric keypad is very useful to quickly enter numerical values but 
also letters when the edition or numeric keypad is displayed on the 
screen (see “Editing” on page 31).

NOTE

All these functions, except HOME, depend on the modules used and 
the measurements made: refer to the user manuals of the corre-
sponding modules of the 4000 Platform.

Fig. 10 Numeric keypad of the Platform
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Control interface
The numeric keypad on the Platform works like the numeric keypad 
displayed on the screen: push on a number to display it.

The numeric keypad of the Platform can also be used when the edition 
keypad is displayed on the Platform screen.

– To enter exclusively numbers, select 123... with the key  and 
type the number(s) wished to display it/them.

– To enter letters and numbers, select abc2... with the key  and 
type as many times as necessary on a key of the numeric keypad of 
the Platform to insert the character wished.

For example, to enter the letter «o», push three times the button 
«6». If you click one again, you will display the number «6».

– Some specific characters (e.g. @, /...) can be entered using specific 
keys from the Platform keypad:

Indicators On blinking green: the instrument, though connected to an
external power source, is switched off.

solid green: the instrument is operating, either by
battery or on an external power supply.

Charge solid green: the instrument is connected to an external
power source and the battery is fully charged.

solid red: the instrument is connected to an external
power source, and the battery is on charge.

Testing blinking red: at least one function is in measurement
phase (for example, the laser emission pilot for an OTDR
measurement).

Direction keys The direction keys have two principal functions:

Key 
pressed

Character displayed one after the other

1 .  ,  -  ?  !  "  @  :  / 1
0 space  0

– on the Results page, they are used to move the cursors 
or modify the zoom factor.

– on the set-up pages, they are used to scroll through the 
menus, the ENTER key serving to select or confirm the 
parameter chosen.
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Using an external keyboard, mouse and touchscreen (options)
Using an external keyboard, mouse  and touchscreen (options)
The external keyboard facilitates input of:

– alphanumerical configuration parameters

– comments in the File menu

– editing characters

The mouse can be used instead of the direction keys to scroll through 
menus and make a selection.

Connect the keyboard and mouse to the USB connectors.

Virtual control
buttons bar

It is possible to emulate hard keys with Virtual Control buttons

To display these buttons, click once on the top of the screen in the status 
bar, at the same height than the date and time.

The virtual control buttons bar is displayed during a few seconds. You 
may click on any of these buttons to obtain exactly the same results than 
using the real buttons in the front panel of the 4000 Platform.

Equivalence
between
external

keyboard and
4000 Platform

Although it is intended primarily to replace the Edit menu of the 4000 
Platform, the external keyboard can replace all the buttons and keys of 
the 4000 Platform except the ON/OFF button: 

– The menu keys to the right of the screen are replaced by the func-
tion keys F1 to F6.

Fig. 11 Virtual control buttons bar

The printing function is available in this bar, whereas no softkey exists 
for this function on the platform.

NOTE

This virtual control buttons bar is especially useful when the 4000 
Platform screen is exported on a remote PC (see "Transfer of the 
interface of the 4000 Platform on to a PC" page 37).
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– The buttons below the screen are equivalent to Ctrl + a letter (see 
table below).

– The direction keys have the same function on the external keyboard 
and on the 4000 Platform.

Editing text
using the

external
keyboard

To use the external keyboard to insert a name or identification in the set-
up menus, or a Note in the table of results:

1 Press Enter to go into the Edit menu

2 Type the text

3 Press Enter to leave the Edit menu.

Pressing the Esc key close the Edit menu without saving the text.

Function on the 4000 Platform External keyboard 

HOME Ctrl + H

SYSTEM SETTINGS F12

SET-UP Ctrl + U

FILE Ctrl + F

RESULTS Ctrl + R

START/STOP Ctrl + S

SCRIPT (Macro)a

a. The Macro function is called on the 4000 Platform using the AUTO key

Ctrl + M

PRINT Ctrl + Pb

b. The Print function is available directly on the 4000 Platform pushing simul-
taneously the left and right arrow keys.



Menu keys 1 to 6 (from top to bottom) F1  F6

ABOUT F11

Save and quit (Exit) Entrée/Enter

Quit without saving (Abort) Escape/Echap.
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Editing1

In the set-up menus, it is sometimes necessary to enter alphanumerical 
information for names of files or results or for comments. 

To call up the Edit menu, select the name to be modified, then press the 
 key. The Edit menu will appear.

This menu can be used to simulate a keyboard: it displays available char-
acters and function keys. Some Edit menus may include keys specific to 
the current function.

The name to be modified is displayed above the keyboard. The cursor 
can be moved about over the name to be modified and the characters 
available, using the direction keys or a mouse or an external keyboard: 
see "Using an external keyboard, mouse and touchscreen (options)" 
page 29.

– The Caps/No Caps key enables the keyboard to type either upper 
case letters or lower case letters and figures (as well as punctuation 
marks and certain special characters).

– The Insert/ Replace key selects the action which will be performed 
by the confirm key ENTER: either insertion of the character selected 
by the position of the cursor, or replacement of the highlighted char-
acter, by the character selected.

1.If an external keyboard is used, see "Using an external keyboard, mouse and touchscreen (options)"
page 29

Fig. 12 Example of Edit menu
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– The 2abc... key allows to use the numeric keypad to enter numbers 
and letters. The 123... key allows to enter exclusively numerical 
values using the numeric keypad. 

– Using the keyboard, with the cursor positioned on the name:

– confirming DEL deletes the character after the cursor;

– confirming CLEAR deletes all characters from the edit line;

– confirming BACK deletes the character before the cursor;

– confirming Cancel will close the edition menu without applying 
the modifications

– confirming HOME moves the cursor to the beginning of the 
word;

– confirming END moves the cursor to the end of the word.

– The Enter key saves the name that has been entered and quits the 
Edit menu.

– The Cancel key quits the Edit menu without saving any changes 
that may have been made.

To enter text:

– Press the Caps/No Caps key, depending on the case of the char-
acter to be entered.

Without Touch Screen Using Touch Screen
- Using the direction keys, move 
the cursor onto the first character 
required.

- Press the ENTER validation key.

The character will appear in the 
upper box.

- Repeat the process for the 
remaining characters.

- Directly click onto the character 
you want.

The character will appear in the 
upper box.

- Repeat the process for the 
remaining characters.
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To delete characters in a text:

To insert characters in a text:

Quitting the Edit menu

– Press the Cancel key to quit without saving the action performed 
(onto the keyboard or on the screen).

– Press the Enter key to quit the menu while saving the text entered 
(onto the keyboard or on the screen).

Numeric
Keypad

For some configuration parameters, you will have to enter numeric 
values. The direction keys of the 4000 Platform can be used. However, 
the user can also use the numeric keypad, displayed when the Edit 
Number key is pressed.

Click on EDIT NUMBER to display the Numeric Keypad.

Without Touch Screen Using Touch Screen
- Go into Replace mode and move 
the cursor on to the character to be 
deleted.

- Move the cursor on to Back (or 
Del) and press the ENTER valida-
tion key.

Repeatedly pressing this same key 
will delete the preceding (or 
following) characters.

-  Go into Replace mode and posi-
tion the cursor on to the character 
to delete.

- Click on the Back touch (or Del) 

Repeatedly clicking on this same 
key will delete the preceding (or 
following) characters

Without Touch Screen Using Touch Screen
- Go into Insert mode and place the 
cursor on the name at the insertion 
point.

- Using the direction keys, move 
the cursor on to the first character 
to be inserted. 

- Press the ENTER validation key.

Repeat the process for the other 
characters to be inserted.

- Go into Insert mode and place the 
cursor on the name at the insertion 
point.

- Directly click on the character you 
want

Repeat the process for the other 
characters to be inserted.
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The keys Min and Max are displayed when the parameter has a 
minimum and maximum value (for example, for the screen lighting level, 
pressing the Min key will display the value -5 and pressing the Max key 
will display the value +5).

– The direction keys  allow to increment of +/-1 the selected value.

– The direction keys  allow to select the previous or the next 
figure.

– Clear key: delete all the displayed value (same function as the Clear 
key of the screen)

– Cancel key: quits the Edit Number menu without saving any 
changes that may have been made (same function as the Cancel 
key of the screen)

– Enter key: saves the name that has been entered and quits the Edit 
Number menu (same function as the ENTER key of the screen).

Modifying / Changing a value with the numeric keypad

When the Edit Number menu  is oopened, the first figure of the value is 
selected.

Fig. 13 Example of Numeric Keypad

Without Touch Screen Using Touch Screen
- Move the cursor to the first 
number to be inserted.

- Press the ENTER validation key.

Repeat the process for the other 
characters to be inserted.

- Directly click on the number to be 
inserted

Repeat the process for the other 
characters to be inserted.
34 User Manual 770000002/04



Chapter 3 Controls of the 4000 Platform
Accessing the 4000 Platform from a PC
Accessing the 4000 Platform from a PC
The 4000 Platform can be connected to a PC in order to:

– remote the screen of the 4000 Platform on to the PC and issue 
commands from the keyboard of the PC

– access the internal memory of the 4000 Platform from the PC and 
transfer files from the 4000 Platform to the PC and vice versa.

Connecting the
4000 Platform

to a PC

Direct connection 1 Connect directly the 4000 Base Unit to the PC with a crossover or 
straight-through Ethernet cable, using the RJ45 connectors on each 
equipment.

2 Make sure the network configuration onto the PC is set to the 
Dynamic mode:

a Click on Start > Control Panel.

b Double click on Network Connection.

c Double click on Local Area Connection.

d In the dialog box, click on Properties.

e Check the parameter Internet Protocol (TCP/IP) is selected 
( ) and click once on it (underlined in blue)

f Click on Properties button.

g On the tab General, check the parameter Obtain an IP address 
automatically is seleted ( ); if not, click on the button to select 
it.

NOTE

The Ethernet card of the equipment connected to the 4000 Platform 
must be configured to the Auto-detect mode (Auto negociation).
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h Click on Ok and close all the dialog boxes opened onto the PC.

3 On the 4000 Base Unit, in the System Setup page, under I/O inter-
face > Ethernet, select Dynamic.

4 Wait for about ten seconds while the connection is established.

Connection via a
local network

1 On the PC: find the IP address and the mask of the PC’s sub-
network:

– With Windows 98 or Millenium: Select Start > Execute, then enter 
winipcfg2 and click on OK. 

– With Windows NT, 2000, XP or Vista: select Start > Programs > 
Accessories > Dos Prompt, type ipconfig", then Enter. 

Note the IP address and the mask of the PC’s sub-network.

2 Plug the RJ 45 connector of the 4000 Platform into a hub or 
Ethernet switch with a straight-through Ethernet cable

3 On the 4000 Platform: 
In the system set-up menu, under I/O interface > Ethernet, select 
Config 1 (or 2 / 3 / 4) on the line Mode, then enter the IP address, 
the IP mask of the PC and the IP gateway communicated to you by 
the network manager; 

Fig. 14 Internet Protocol

Fig. 15 System Setup > Ethernet: Dynamic mode

2.The character _ corresponds to a space.
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or

on his recommendation, use Dynamic attribution mode (DHCP). In 
this case, the address of the 4000 Platform (10.10.50.204 in the 
example) is displayed but cannot be altered.

4 Wait for about ten seconds while the connection is established.

5 On the PC, make sure that the connection is operational by 
selecting Start > Execute... and typing ping followed by the 
address of the 4000 Platform.

Transfer of the
interface of the

4000 Platform
on to a PC

1 Make the 4000 Platform / PC connection as described above.

2 On the 4000 Platform in the system set-up menu, under I/O inter-
face, confirm Remote screen = Session / Permanent / Permanent  
with password (for more information, see "Remote screen" page 
51).

3 On the PC, go into Internet Explorer and type the address: 
http://10.10.50.204:5800
if 10.10.50.204 is the IP address of the 4000 Platform that was 
defined when the connection was set up.

A VNC window will open demanding a password: press Enter 
without typing any password.

The screen of your 4000 Platform will then appear offset on to your PC. 
You can use the keyboard and mouse of the PC to control the 4000 Plat-
form: see "Using an external keyboard, mouse and touchscreen 
(options)" page 29, for the command equivalents between the controls of 
the 4000 Platform and those of the PC keyboard and mouse.

Moreover, via the VNC window, you can launch a rebooot of the Platform, 
typing Ctrl + Q on the PC keyboard and validating.

For an intensive use of the deport screen or when it is used via a 
WAN network, it is strongly recommended to use a dedicated VNC cli-
ent. The VNC clients recommended are Tight VNC (V 1.2.9) and Real 
VNC (V 4.1.1).
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Accessing the
internal

memory or the
USB memory

stick of the
4000 Platform

via a PC

Il is possible, from a PC, to access the internal memory of the 4000 Plat-
form or to the  USB memory stick connected to the Platform  by means 
of the FTP server of the 4000 Platform. 

FTP access is obtained through the user account «fttx» (password: fttx).

1 Make the 4000 Platform / PC connection as described above.

2 On the PC, use either an FTP client or Internet Explorer.

3 In Internet Explorer, type the following address (10.10.50.204, 
which is the IP address of the 4000 Platform that was defined when 
the connection was set up):

ftp://mts4000:JDSU@10.10.50.204/disk/
This allows to access to internal memory.

ftp://mts4000:JDSU@10.10.50.204/extmem/
This allows to access to extended internal memory (option).

ftp://mts4000:JDSU@10.10.50.204/usbflash/
This allows to access to the contents of the USB memory stick 
connected to the 4000 Platform.

The PC then displays the contents of the internal memory, of the internal 
extended memory or of the USB memory stick of the 4000 Platform.

Creating a shortcut
toward the 4000

Platform internal
memory

You can add on your PC, a direct connection to the internal memory of 
the 4000 Platform, creating a shortcut in the network place, in the 
Explorer.

To create a network place, do as follows:

1 Open the Explorer on your PC

2 Double click on Add Network Place

The Wizard for the Network Place installation opens

If you use Internet Explorer 7, the following adress must be entered:

ftp://mts4000:JDSU@10.10.50.204/acterna/user/disk or 
ftp://mts4000:JDSU@10.10.50.204/acterna/user/ext-
mem or  ftp://mts4000:JDSU@10.10.50.204/acterna/user/
usbflash
38 User Manual 770000002/04



Chapter 3 Controls of the 4000 Platform
Accessing the 4000 Platform from a PC
3 Click on Next

4 In the dialog box, click on  , then on 
Next

5 In the following dialog box, type the following address 
(10.10.50.204, being the IP address of the 4000 Platform defined 
during connection):

ftp://mts4000:JDSU@10.10.50.204/disk
(access to internal disk of the 4000 Platform)

6 Click on Next

7 Enter a name for this Network Place

Fig. 16 First page of the installation

Fig. 17 Entering the ftp address

NOTE

You can access to the internal extended memory (option) or to the 
USB memory stick connected to the 4000 Platform typing respectively 
extmem or usbflash instead of disk.
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8 Click on Next

The PC is searching for the connection

9 The last dialog box inform you the network place has been success-
fully created, and will be open once you click on Finish.

Deselect this parameter if the internal memory of the 4000 Platform 
must not be opened on the PC.

In the Explorer > Network Place, the new shortcut is displayed, with 
the name applied on step 7.

Fig. 18 Name of the Network Place

Fig. 19 Completion of the Network Place installation

Fig. 20 Network Place created
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Connectors
Connectors

Upper panel The upper panel contains, from left to right, the following elements (see 
example below):

– the connection socket for the mains adapter providing the 15 V 
power supply and used to charge the battery,

– the RJ 45 connector for the Ethernet interface, 

– the headset plug-in

– the 2 USB connectors for printer, mouse, keyboard, USB memory 
stick...

– the powermeter plug-in if the option is available

– if the VFL option is present, the corresponding output

– the internal memory extension, which is delivered on option and 
cannot be reached by the user

USB memory sticks can be very different.

They differ on Hw and Sw aspects, even inside a given brand.

In particular, USB memory sticks targeting audio recording are often 
formatted in very specific ways and the format is often very different 
from a standard FAT.

For all these reasons, we advise users to use memory sticks provided 
by JDSU.

In any case, USB memory sticks which are recognized by the 4000 
Platform (a sound is generated when plugged on the 4000 Platform) 
but which cannot be read or written, should be formatted on the 
4000 Platform with the Usbflash Format utility, in Expert tools > 
Media utilities.

If a problem occurs with the USB stick you are using, contact your 
Local Technical Assistance Center.
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Fig. 21 Example of upper panel

 VFL output

USB

RJ 45

Headset

Power Meter

Internal memory extension 
(option; not available by user)

AC/DC mains

Options
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4

This chapter describes the operations for configuring the instrument 
(choosing the module or function to be used) and the system (date, 
language, input/output, etc.).

The topics discussed in this chapter are as follows:

– “Principle of the set-up menus” on page 44

– “Configuring the instrument” on page 44

– “Configuring the unit” on page 47

– “Standalone results” on page 58

– “Expert Tools” on page 59
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Principle of the set-up menus
The procedures described below usually use the direction keys. When the instrument 

is equipped with a mouse or/and a touch screen:

- the user must adapt the text to the option used; which means that for touch screen 

and mouse, the user must directly click on the desired field.

- to edit a string of characters, the  key of the equipemnt must sometimes be used.

Principle of the set-up menus 
A set-up can be displayed or modified while an acquisition or measure-
ment is in progress. The parameters that cannot be modified are greyed 
out. The menu thus gives all the possible options.

– To move from one parameter to another, use the direction keys  
and . When a parameter is selected, its possible values are 
shown to the right of the parameter.

– To modify the value of a parameter, use the direction keys  and  
to highlight the option selected.

– To leave a set-up menu the user can press any of the keys below 
the screen or the menu key Exit.

Configuring the instrument
Since the instrument can be equipped with a range of modules and plug-
ins, a variety of functions are possible. Before carrying out a particular 
measurement, it is therefore necessary to select the function or functions 
required for it

If a module has been changed, the instrument configuration menu will 
automatically be displayed as soon as the power is switched on.

The functions of Reflectometry, Visible Source (VFL), Power Measure-
ment (Radiometry) are not mutually exclusive: several functions can be 
active at once.

To configure the instrument, proceed as follows:

– Press the HOME button.

The functions available on the instrument are represented graphi-
cally by icons.
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To validate a function:

– Move on to the icon representing the function to be validated using 
the direction keys (or the mouse or external keyboard if the corre-
sponding option is present).

– Press the ENTER validation key to confirm the selection. The icon 
turns yellow and is outlined with a white frame.

Validating
several

simultaneous
functions

It is possible to validate several distinct functions, whether or not they are 
elements of the same application. Thus it is possible, for example, to acti-
vate the microscope function at the same time as the OTDR function by 
validating each of them.

When several functions are validated, pressing the keyboard keys 
(SETUP, FILE, RESULTS, START/STOP) will give access to the function in 
focus (in yellow).

To change from one function to another:

– If the functions are elements of the same application (for example, 
Optical Fibres), simply change tabs (refer to the manual corre-
sponding to the application).

Fig. 22 Example of instrument configuration

Module
Reference

NOTE

You can also use the numeric keypad of the base, selecting the num-
ber displayed for each function.
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– If the functions are not elements of the same application (for 
example, to change over from the OTDR function to the VFL func-
tion), return to the instrument configuration screen shown here and 
place the focus on the VFL function. The actions of the keyboard 
keys will then indeed be those corresponding to the VFL function.

Help The Help Page from the HOME menu display the Getting Started manual 
contents, in a web page (in english).

About The About page allows to display the presentation screen, with all the 
information concerning the softwares versions, the hardware options and 
the module installed (see Figure 8on page 20).

Once this page is displayed, you can click on the Software Options key 
to visualize the software options available on the 4000 Platform, ordered 
according to specific categories (Copper, DSL, Ethernet, OTDR ...). Use 
the direction keys to scroll through the options available 

Fig. 23 Software Options page
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In ths About page, you can also click on Services Data key, which allow 
to display information about the elements inside the Platform (CPU, 
Memory, hardware revision, screen reference...).

The Patents page allows to display the number of the patents according 
to the configuration of the 4000 Platform of client.

Configuring the unit
When the 4000 Platform is to be used for the first time, or before a 
measurement campaign is started, the parameters of the system must be 
configured:

Fig. 24 Services Data page

Fig. 25 Patents screen
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– the parameters specific to the 4000 Platform (screen lighting level, 
automatic shutdown).

– the parameters specific to the country of use: language, date, time, 
display format of date and time.

– parameters of input/output.

– audio parameters (heaset / hands-free) and regulation of sound 
level 

– programming of automatic shutdown (during battery operation).

– IP adress for upgrading via the network

– parameters for printing

To call up this configuration menu, press the HOME button, then System 
Settings.

Factory Default
Configuration

Screen

– Backlight: +0

– Contrast: Indoor

– Screen Saver: No

I/O Interface

– Remote Screen: No

– Ethernet: Config. 1 / Security: Standard

NOTE

The key FACTORY DEFAULT allows to reinitialize the configuration set 
in factory, in case of error during the new configuration.

Fig. 26 System configuration screen
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– File Export: None

– Bluetooth: Disable

–  Use proxy: No

Country

– Language: English

– Date Format: dd/mm/yyyy

– Time Format: 24 hour clock

Audio

– Channel: Hands-free

– Hands-free Volume: 0

– Headset Volume:0

Utility

– VFL Mode: 1Hz

– Auto off: 30 minutes (only on battery operation)

– Upgrade Parameters: Server name: 4k.updatemyunit.net

– Home Selection: Multiple

Printer

– Printer : None

Screen Choosing screen lighting level

In the Screen window, move the cursor on to Lighting.

– use the direction keysorto choose the desired lighting level 
(between -5 and +5).

or

– click on Edit Number to enter the screen lighting level on the 
numeric keypad

NOTE

The Bluetooth selection appears only if the option is installed on your 
unit. It requires factory-installed hardware.

If the 4000 Platform is operating on battery, it is advisable to choose a 
minimum lighting level acceptable for the user, to keep endurance as 
long as possible.
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Contrast

– Indoor: to be selected when the instrument is used inside (see 
Figure 26on page 48)

– Outdoor: to be selected in order to optimize the readability of the 
screen for an outside use.

Screen saver

This feature is available both when battery powered 
or AC powered. Its purpose is to extend the life of 
the screen, in case the 4000 Platform is not used for 
some time. Instead of the normal screen, a small 
animated picture is displayed on the blackened 
screen, eventually followed from time to time by a 
name and phone number (if configured by the user).

To configure this feature, select Screen Saver.

A sub-menu is displayed :

Screen saver 60s, 3 min, 5 min, No. 

No: disables the screen saver. 

Other values indicate time of inactivity before the 
screen saver automatically starts. If the screen 
saver is enabled (a time is set), the following two 
lines are proposed.

Name A name or comment may be entered. This name
or comment may be usefull to persons who find
the 4000 Platform in the screen saver mode.
Information such as who currently uses the
apparatus, where to find the person or any other
commercial information may be entered.

Fig. 27 Example of Outside contrast
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Phone number A phone number or other comment may also be
added in order to provide more information :
number to call in case of emergency, user
telephone number...

Country Choosing language (Language)

Select one of the languages offered, using the direction keys or.

Resetting the date

Change the date by using the direction keysor

Resetting the time

– Use the direction keys or to change the minutes and hours

Choosing date and time format

Choose one of the options: dd/mm/yy or mm/dd/yy for the date format.

Use the direction keys or to change the hour format (12 hour clock 
/ 24 hour clock).

I/O Interface Remote screen

It is possible to remote the screen of the 4000 Platform on to a PC and 
to read the contents of the disk of the 4000 Platform on a PC. To do this, 
see ."Accessing the 4000 Platform from a PC" page 35

Remote screen = Session or Permanent  or Permanent with Pass-
word must be confirmed in both cases, in the Interface E/S window.

Session Mode the remote screen function is inactive once
the 4000 Platform is switched off.

Permanent Mode the remote screen function is still active
when the 4000 Platform is switched off and
restarted.

Permanent with Password same function as the Permanent mode, with
an access to the equipment via VNC
protected by a password: 42000

No the screen cannot be remote on a PC.

NOTE

The ENGLISH CAPS parameter allows to get a display in English, 
with all words in capitals.
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Ethernet

Parameters of the local Ethernet network to which the 4000 Platform is 
connected:

Mode - Config 1 to 4 static mode enabling input of the configuration of
4 sites.

- Dynamic in this mode, which requires a DHCP server, the
4000 Platform requests an IP address from this
server which will be allocated dynamically if
dynamic host configuration is activated on the
local network.

After selecting this mode or after power-on, the
4000 Platform tries to establish a connection to
obtain an address from a DHCP server. If for any
reason, this process fails, the 4000 Platform
reverses to static IP address mode with User1 IP
address.

Site Name the user can enter the name of the site in the Edit
menu.

IP Address IP address of the 4000 Platform

IP Mask address of the mask of the sub-network

IP Gateway IP address of the machine enabling access
outside the sub-network.

DNS1 IP address of the machine providing the IP
address on the basis of the name

Domain name name of the local network to which the 4000
Platform is connected.

NOTE

When the equipment is in the Remote screen mode, the icon  is 
displayed at the bottom of the screen.

1.Domain Name Server

NOTE

NOTE

Once the 4000 Base-Unit is connected to the network, the icon  
turns   indicating the connection is working
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File Export

In the I/O Interfaces menu, select File Export to configure the system in 
order to send traces and results by e-mail. Parameters to configure the 
mail feature.

Send Mail Choose Ethernet if you wish to use the sending
mail function.

If Enable has been selected on the Bluetooth
line, select Bluetooth to send files using the
Bluetooth option 

Sender Mode Auto or Manual. 

In Auto mode, you will not have the possibility to 
reply to the mail sent.

In Manual mode, the reply will be sent to the 
address entered in the line From. Use the button 

 to enter into an edition window

Relay Mode Auto or Manual. 

If the e-mail sending is performed via a SMTP
network, select the Manual Relay mode and
indicate the SMTP server address in the field
Mail Relay, using the button  to open the
edition window.

In Auto mode, the sending of e-mail is performed
automatically.

See "Sending files by mail" page 174 for more explanation on sending 
files.

Bluetooth 

The Bluetooth selection appears only if the interface is installed on your 
unit. It requires factory-installed hardware.

Select Disable to deactivate or Enable to activate the Bluetooth option.

Audio

If Sender Mode is set to Auto, any reply to an e-mail sent by the 4000 
Platform will be lost.

NOTE

If the Bluetooth is activated (Enable), the icon  is displayed on the 
upper banner of the screen.
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Use proxy: 

– If Manual has been selected, enter the Proxy Address.

– If Auto has been selected, enter the Pac Address.

Audio Channel

Select the Hands-free function or the Headset

– If the Hands-free function has been selected, adjust the volume in 
the line Hands-free Volume.

– If the Headset function has been chosen, adjust the volume in the 
line Headset Volume

Utility VFL Mode

Select the mode of emission of the light signal:

– 1 Hz: frequency of 1Hz (blinking signal)

– CW: signal is emitted in a Continuous Wave

Auto off

This function switches off the 4000 Platform automatically if no operation 
has been performed and no key actuated for a period selected from this 
menu. Work in progress is automatically saved.

– To activate this function, open the Utility window and move the 
cursor on to Auto off, then choose an option (5, 10 or 30 min.) so 
that the 4000 Platform will be automatically switched off if no key 
has been actuated for the period selected.

– To deselect this function go into the Utility window, move the cursor 
on to Auto off, then choose option No.

Upgrade parameters

When updating the software (see "Installing a new version of the soft-
ware" page 180):

– In the server IP address line of the configuration menu, enter the IP 
address of the PC on which the updating files were loaded.

NOTE

The function for automatically switching off the 4000 Platform is avail-
able only on battery operation, to save the battery.
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or

Select Server Name and enter the name of the server in which the 
updating files are set.

Home selection

Multiple / Single

This configuration menu allows to choose if, on the Home page, only one 
function can be deselected (Single) or several functions can be selected 
at the same time (Multiple).

Printer Parameters for configuring an internal printer, a USB printer or for saving 
JPG files.

Printer USB, USB (Land), Files (Formatted), Files
(Screen), None.

USB and USB
(Land)

If you choose USB, you can configure:

Printer manufacturer Use the keys  and  to select the
manufacturer corresponding to the printer you
wish to configure. By default, a model type will
automatically be proposed on the next line,
corresponding to your manufacturer choice.

Printer type If the model type set by default for the chosen
manufacturer is not correct, you may change it
using the keys  and .

ASCII Mode Select Graphic or Text according to the printer
configuration. Some printers do not recognize the
ASCII mode, so that you must select Graphic to
print files from the Web Browser.

Logo Select the Logo to be displayed on the upper
right of the page: select the line, and press  to
enter the path of the logo file in the edition
keypad. Press Enter to validate

The parameter USB Land allows to configure the printer as the USB 
parameter, but also to print with landscape setting.

NOTE

If the mode Simple is selected, the activation of a function in the 
Home page will automatically display the result page for this function.
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Files (Formatted) Choosing in the Printer menu, the option Files (Formatted), you can 
print the open file of the 4000 Platform in the JPG, PNG or PDF format, 
exactly as if the file was printed on paper. Therefore, if the file (trace or 
other) is too large for one A4 page, several JPG, PNG or PDF files will be 
created.

Printing a trace to the JPG/PNG/PDF format

1 Select the Files (Formatted) function

2 Select the File Format: JPG / PNG / PNG on the second line.

3 Select the logo to be displayed on the upper right of the page:

a Select the line Logo

b Press the right direction key to open the Edition keypad

c Enter the full path and name of the file containing the logo 

Example: disk/Logo/JDSU.jpg (media/directory/file name)

d Press Enter to validate

The logo will be displayed on the upper right part of the file.

4 Open the trace to be printed in the JPG format

5 If necessary, make the modifications on the trace (see user manual 
of the 4100 OTDR Modules).

6 Set the trace view as wished:

– if the function is set to the Trace mode (Trace is selected on the 
menu key Trace/Table/Summary), the JPG/PNG/PDF file will 
countain the header and the trace (in one page).

– If the function is set to Table mode (Table is selected on the 
menu key Trace/Table/Summary), the JPG/PNG/PDF file will 
countain the header, the trace and the entire results table 
(several pages may be required)

– If the function is set to Summary mode (Summary is selected 
on the menu key Trace/Table/Summary), the JPG/PNG/PDF 
file will countain the header and the summary page. This view is 
only available with OTDR traces.

7 Launch printing by pushing simultaneously the left and right direc-
tion keys 

The icon  is displayed until the saving process is finished

NOTE

If several traces are displayed in overlay, the JPG/PNG/PDF file will 
print exclusively the data for the active trace.
56 User Manual 770000002/04



Chapter 4 System set-up
Configuring the unit
8 Press the FILE key to find the JPG file in the Explorer

The name of the JPG/PNG/PDF file will be: name of the stored 
trace_date (year/month/day)_time (hour/minute/second).jpg/png/
pdf

Printing another file to the JPG/PNG/PDF format

1 Select the Files (Formatted) function.

2 Select the File Format: JPG / PNG / PNG on the second line.

3 Select the Logo to be displayed on the upper right of the page:

a Select the line Logo

b Press the right direction key to open the Edition keypad

c Enter the full path and name of the file containing the logo 

Example: disk/Logo/JDSU.jpg (media/directory/file name)

d Press Enter to validate

The logo will be displayed on the upper right part of the file.

4 Open the file to be printed in the JPG, PNG or PDF format (for 
example: Microscope etc.)

5 Launch printing by pushing simultaneously the left and right direc-
tion keys 

The icon  is displayed until the saving process is finished

6 Press the FILE key to find the JPG/PNG/PDF file in the Explorer

The name of the file will be: Print_date (year/month/day)_time (hour/
minut/second).jpg/png/pdf

Files (Screen) Choosing in the Printer menu, the option Files (Screen), you can print 
the open file of the 4000 Platform in the JPG, PNG or PDF format, exactly 
as it is displayed on the screen.

Therefore, if you make a zoom on the trace for example, the file will only 
show the zoom section.

NOTE

The file will be saved in the current directory, the last directory used.

NOTE

The JPG/PNG/PDF file will be saved in the directory PRINT, on the 
internal memory of the 4000 Platform.
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1 Select the Files (Screen) function.

2 Select the File Format: JPG / PNG / PNG on the second line.

3 Open the trace or file to be printed.

4 Make the necessary modifications

5 Launch printing by pushing simultaneously the left and right direc-
tion keys.

The icon  is displayed until the saving process is finished

6 Press the FILE key to find the JPG, PNG or PDF file in the Explorer

The name of the JPG file will be: Print_date (year/month/day)_time 
(hour/minut/second).jpg/png/pdf wether it is a trace file or not.

Applications

PDF and Web
Browser

Those desktop applications are available with the 4000 Platform.

It opens the same page as the pushing the FILE button.

For more information about this function, see Chapter 6 on page 75.

File Explorer This function open the file explorer page. See Chapter 11 on page 163.

Standalone
results

Even if no module is present, the 4000 Platform can access and display 
measurement results.

To access this feature, select App’s > Standalone Results, and choose 
the desired application, for example Consult Fiber Optics.

NOTE

The JPG, PNG or PDF file will be saved in the directory PRINT, on the 
internal memory of the 4000 Platform.
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Expert Tools

Upgrades The Upgrades key allows to make an upgrading of the softwares (see 
“Installing a new version of the software” on page 180).

Install Option This page allows to import the licence to get a software option.

To import the license, you can either enter manually the licence code, 
given in the license file, (.lic file) or import this file with a USB memory 
stick connected to the 4000 Platform.

Enter Manually the
Licence

1 In the Home page, click on Expert Tools > Upgrades > Install 
Option > Enter License

The edition keypad is displayed

Fig. 28 Example of a License file (.lic)

Licence Code

It is strongly recommended to perform the installation using the 
importation of Licence via a USB memory stick.
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2 Enter the challenge code of the option, set at the bottom of the file 
(see Figure 28on page 59),

3 Press the Entrer key to validate the code

Your software options will be installed

At the end of this sequence you will be asked to reboot the unit to 
apply the modifications, pushing the key . Confirm the reboot 
to restart the Platform.

Import the license
from the USB
memory stick

1 In the Home page, click on Expert Tools > Upgrades > Install 
Option > Import License

If the USB memory stick is not already connected to the Platform, a 
message asking the memory stick insertion is displayed. Confirm it 
once the stick is connected.

2 In the File Explorer, select the USB stick, then the license file (.lic) to 
be imported,

3 Click on Load > Confirm

4 The challenge codes contained in this file will then be loaded auto-
matically and your software options will be installed.

Fig. 29 Enter the Licence code

The license file can be opened via a word processing software 
such as Word...
The challenge code must be entered exactly as it is in the .lic file, 
paying attention to the lower-case and upper-case letters etc.
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At the end of this sequence you will be asked to reboot the unit to 
apply the modifications, pushing the key . Confirm the reboot 
to restart the Platform.

Media utilities To get access to the menu, click on Expert tools then on Media utilities.

Formating a USB
memory stick

In order to format a USB memory stick, select Media utilities, then 
Usbflash Format. Confirm your choice to actually format the USB 
memory stick.

Fig. 30 License imported

As for any media formatting, please note that all data present on 
the USB memory stick will be irremediably lost. 
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Removing the USB
memory stick

Once a USB memory stick is inserted in one of the USB port of the 4000 
Platform: it can be removed via the Media Utilities menu.

1 Click on Expert Tools > Media Utilities

2 Push the Eject USB key,

The icon becomes  to indicate it can be removed safely. In this case, 
the USB stick cannot be used anymore

The USB memory stick can then be disconnected from the 4000 Plat-
form's USB port.

The disconnection of the USB memory stick produces one beep.

Erase disk / Erase
Extmem

In Media Utilities, select Erase Disk or Erase Extmem to delete all the 
disk contents or all the extended internal memory contents into the 4000 
Platform.

A confirmation must be validated before the deletion.

Formating an
extended internal

memory

In order to format an extended memory (delivered on option), select 
Media utilities, then Usbflash Extmem. Confirm your choice to actually 
format the extended memory.

USB memory sticks can be very different.

They differ on Hw and Sw aspects, even inside a given brand.

In particular, USB memory sticks targeting audio recording are often 
formatted in very specific ways and the format is often very different 
from a standard FAT.

For all these reasons, we advise users to use memory sticks provided 
by JDSU.

In any case, USB memory sticks which are recognized by the 4000 
Platform (a beep is generated when plugged on the 4000 Platform) 
but which cannot be read or written, should be formatted on the 
4000 Platform with the Usbflash Format utility in Expert tools > 
Media utilities.

If a problem occurs with the USB stick you are using, contact your 
Local Technical Assistance Center.

NOTE

The USB memory stick can also be removed via the File menu (see 
“External USB storage media” on page 165).
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Expert Tools
Locking the
4000 Platform

The 4000 Platform can be locked at any time:

1 In the HOME page, click on Expert Tools

2 Click on Instrument Lock Out

3 Confirm the 4000 Platform locking by clicking on Confirm (or use 
the Cancel key to cancel the process).

The numeric keypad is displayed

4 Entrer the password to lock the instrument: 42000 (see "Example of 
Edit menu" page 31)

5 Click on Enter

The 4000 Platform locking screen is displayed.

As for any media formatting, please note that all data present on 
the extended memory will be irremediably lost. 

Fig. 31 Password
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Click on the Notepad Message key to add a message using the text 
edition (see "Example of Edit menu" page 31).

Unlocking the 4000 Platform

– Once the locking screen is displayed, click on the key Unlock 
Instrument.

– Enter the password 42000 using the numeric keypad (see "Numeric 
Keypad" page 33) and validate.

The screen automatically displays the HOME page.

Fig. 32 Locking screen
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5

A variety of options are available when ordering. Option 40PM consists 
of a power meter; the option 40HPPM consists of a High Power power 
meter with universal  2.5 MM UPP adapter; the option 40VFL consist of 
a VFL with a connector 2.5MM and the option 40PMVFL consists of an 
optical power meter and a VFL, with 2.5 mm UPP connectors. See refer-
ences in "References of options for the 4000 Platform mainframe" page 
196, for wavelengths of the sources in each option.

The topics discussed in this chapter are as follows:

– “Principle of optical power and attenuation measurements” on 
page 66

– “Connection to the power meter” on page 67

– “Configuring the Power meter” on page 67

– “Display of results and commands” on page 69

– “Making a measurement” on page 71

– “VFL Function” on page 73

– “Storing and reloading results” on page 73
User Manual 770000002/04 65



Chapter 5 Power meter and VFL (Visual Fault Locator)
Principle of optical power and attenuation measurements
Principle of optical power and attenuation measurements

Power
measurements

A power meter, is all that is needed to measure emitted or received 
power:

– to measure emitted power, connect the power meter directly to the 
output of the optical emitter;

– to measure the power at the input of an optical receiver, the power 
meter is connected to the end of the fiber, at the point where the 
optical receiver would be connected.

Attenuation
measurements

(optical link
loss)

For measurement of the attenuation of power in a complete link or in 
elements such as sections of fiber, connections or optical components, a 
light source and a power meter are required. 

This attenuation is usually deduced from the measurement of optical 
power at two points:

Attenuation A(dB) = P1 (dBm) - P2 (dBm)

To perform accurate measurements, the following conditions are vital

– Use a light source which is stable both in time and as a function of 
temperature.

– Make sure that all connections and fibers and the receiving cell are 
perfectly clean.

– Use a reference link between the laser source and the test subject. 
If several measurements are to be made under identical light injec-
tion conditions, this reference fiber must not be disconnected during 
the period while measurements are taking place.

Insertion loss method

1 The power meter is first connected to the laser source via the refer-
ence fiber: P1 is measured.

2 Then the fiber to be tested is inserted between the reference fiber 
and the power meter: P2 is measured.

The difference between P2 and P1 gives the attenuation of the fiber 
under test.

Laser light 
source Reference 

fiber
Link under test 

Power meter of the 
MTS/T-BERD 4000

1 2
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Connection to the power meter
It is preferable to use the same type of connector at both ends of the 
fiber being tested, to ensure the same connection conditions for 
measuring P1 and P2.

Accuracy of measurements

– A high degree of accuracy is often required. It is then necessary to 
perform a preliminary calibration without the fiber under test to elim-
inate the losses due to connections as far as this is possible. To do 
this, use the «Reference Value» function.

Connection to the power meter

The type of optical connector used for the power meter is UPP (Universal 
Push Pull), which is compatible with all diameter 2.5 mm connectors (FC, 
SC, ST, DIN, E2000, etc.)

Configuring the Power meter
The power meter function is an option chosen at the time of order and 
incorporated into the MTS/T-BERD 4000 in the factory.

To activate the function:

– Press the HOME button

– Use the direction keys to select the power meter icon  
(framed in white)  and press the ENTER key : the icon is selected. 

The effect of this action will to be to bring the power meter into use.

Fig. 33 Optical connectors

Power meter optical 
connection

VFL
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Configuring the Power meter
Configuring the
measurement
parameters of

the power
meter

The measurement parameters can be accessed with the SETUP key.

Wavelength Selecting wavelength:
- Auto: the wavelength of the input signal will be
automatically detected and selected to perform
the measurement:
850, 980, 1300, 1310, 1420, 1450, 1480, 1490,
1510, 1550 or 1625 nm: measurement performed
at specified wavelength.
- User: choice of wavelength on the next line

User choice (if the User option was selected in the Lambda
line) selection of the wavelength between 800
nm and 1650 nm, in 1 nm steps, by means of the
direction keys and .

Beep on Modulation Select if a sound must be heard whea a
modulation occurs (Yes / No)

Unit Unit of power displayed:

- Watt, dBm for displaying absolute power

- dB for displaying a result relative to a reference
(link loss)

Reference level If dB units were chosen in the previous line,
selection of the reference value for the
wavelength selected. Using the direction keys,
first choose the wavelength, then press the > key
to access choice of the value (+XXX.XX), then
confirm this value with the ENTER key.

This reference is also automatically available, in
the Results page, using the Set as Reference
key.

Attenuator compensation
Choice of level to be applied to the wavelength
chosen for measurement to compensate for the
loss due to the external attenuator (+XX.XX dB).
First use the direction keys to choose the

Fig. 34 Configuration of power measurement
68 User Manual 770000002/04



Chapter 5 Power meter and VFL (Visual Fault Locator)
Display of results and commands
wavelength, then press > to access choice of
value, then confirm this value by pressing
ENTER.

Configuring the
alarm

parameters of
the power

meter

Alarm Activation of the Alarm function : any result below
the lower threshold or above the upper threshold
will be displayed in red on the Results page.

Min and max thresholds :

Choice of lower and upper thresholds for each
available wavelength, from -60 to +40 dBm
(selected with the direction keys).

Display of results and commands
The results page called up by the RESULTS button, gives the information 
relating to the measurement in progress, results previously saved and 
the commands available for measurement and saving.

Result of the
measurement in

progress

The power measured by the power meter is displayed in large charac-
ters, in the units selected in the SETUP menu, together with:

– the mode of transmission of the signal measured: continuous (CW) 
or modulated to a frequency of 270Hz, 330Hz, 1KHz, or 2KHz.

– the wavelength of the signal measured. 

– the reference level expressed in dB.

– the level of Attenuation Compensation.

NOTE

To copy a Reference Level or a Attenuator Compensator on all wave-
lengths, select the reference wavelength and click on Update for All 
Wavel..

NOTE

To copy one value of the Lower or/and Upper threshold for all wave-
lengths, select the reference value and click on Update for All 
Wavel..

NOTE

A continuous push on direction keys increments the value by 10 dBm.
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Table of results For one and the same fiber, the power meter displays a table of 9 results 
corresponding to the different possible wavelengths. The first 4 results 
are displayed on the screen; to scroll through the other results, use the 
direction key . The table shows the power measured in dBm, the rela-
tive power (in dB) and the reference level in dBm (if units = dB), together 
with the mode.

– A measurement result is displayed in the table when the Keep 
Result softkey is pressed. 

– The Clear Table softkey orders deletion of all the results displayed 
in the table. 

– If the Alarm function has been activated, any result that exceeds the 
selected thresholds appears in red in the table. Otherwise, results 
are shown in the table in green.

– When the instrument is switched off, results present in the table are 
saved.

Commands of
the power

meter
parameters

When the LTS function is selected, the following softkeys are available 
on the results page:

Keep Result Saves the result on the corresponding line of the
table.

Clear Table Deletes all the results recorded in the table.

Pressing the Powermeter Config. key allows to reach the following 
function:

Wavelength Allows to modify the wavelength to be applied
with the Power meter.

Fig. 35 Results and commands of the power meter

Results
of  the
power meter
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Making a measurement
Unit Allows to modify the unit of power displayed (dB,
dBm, nW) 

Zero Adjustment of the Zero value when the power
meter’s optical input is closed with a plug (a
validation is required).

Click on Exit to go back to the Results page.

Pressing the Pow. Reference key allows to reach the following function:

Standard Reference Selects the current result as reference value to
measure the attenuation of a link. This reference
is displayed under the measurement result until a
new reference value is chosen.

Jumper Reference This key can be pressed when a reference in
loopback mode must be performed (see 4100
Module Series User Manual).

Making a measurement
The power meter is started up as soon as the function  is acti-
vated in the HOME menu.

Power
measurement

– Connect the light source to be tested to the rear connector (see 
"Connection to the power meter" page 67).

– In the SETUP menu, choose the units dBm, dB or Watts.

– Press the START/STOP key to start the measurement. 

The result will appear in the results page and can be memorized in 
the table (see "Table of results" page 70).

– Press the START/STOP key to stop the measurement.

The soft key Jumper Ref is displayed in grey and cannot be 
activated if both power meter and Source are selected onto the 
OTDR Module set into the Platform.
The power meter must be selected onto the Base-Unit, and the 
Source onto the OTDR Module to activate the soft key and be 
able to perform a reference measurement in loopback mode.

Power measurement is automatically updated in consequence. The 
value «<-60 dB» is displayed when the laser is switched off and if the 
source output is looped on to the power meter input.
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Making a measurement
Optical link loss

Setting the zero
value of the power

meter

1 Fix the plug over the optical input of the power meter so that no light 
can reach the photodiode of the power meter. If the zero adjustment 
is made without this plug, an error message may be displayed, as 
the photodiode will detect too much light.

2 In the Results page, press the Powermeter Config. > Zero soft key 
and validate.

Carrying out the
reference

measurement

1 Fix the adapter corresponding to the jumper to the optical connector 
of the power meter.

2 Connect the jumper between the input of the power meter and the 
output of the source.

3 Configure the same wavelength on the source and the power meter.

The power measured is displayed in the results page of the power 
meter.

4 Press the Pow Reference > Standard Ref soft keys to save the 
result displayed as reference value.

Measurements on
the fiber under test

After defining the reference value, proceed as follows to make the 
measurement:

1 Fix the jumpers and connectors needed to connect the fiber to be 
tested between the source output and the power meter input.

2 In the set-up menu, select dB units.

3 The power displayed in the Power Meter window corresponds to the 
optical loss of the link tested. It can be displayed in the table (see 
"Table of results" page 70).

It is important to set the zero of the power meter before making any 
measurements where accuracy is required, as the noise from the ger-
manium photodiode fluctuates over time and with variations in tem-
perature.
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VFL Function

VFL connector The type of optical connector used for the VFL source is UPP (Universal 
Push Pull), which is compatible with all diameter 2.5 mm connectors (FC, 
SC, ST, DIN, E2000, etc.)

See Figure 33 on page 67 to visualize the VFL connector.

Visual Fault
Locator

function (VFL)

This function is used to emit a red light signal of frequency 1 Hz or in 
continuous mode into a fiber to detect any defects in the dead zone of the 
reflectometer, or to identify it. 

This function is suitable for short fibers (length < 5 km) or the first few 
metres of a long fiber.

To emit a light signal into a fiber:

– Connect the fiber to the VFL port on the connectors panel (see 
Figure 33 on page 67)

– Press the HOME key, then press <- and -> to select the VFL icon 
and confirm by pressing the ENTER key.

– You can configure the signal mode in the System Settings page > 
Utility > VFL Mode (see “VFL Mode” on page 54).

Selection of this option is compatible with another function (OTDR, etc.).

Storing and reloading results

File Setup Click on the button FILE to access the File setup. See the chapter «File 
management» in the user manual «4100 modules series» for a complete 
description of all parameters, options and the explorer.

Storing results In order to save the results of a measurement, click on FILE and select 
Store trace. Two files are being saved :

NOTE

Identification is facilitated by the blinking of light in the fibre.
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Storing and reloading results
– The first file is to be used with the MTS/T-BERD 4000 and allows to 
retrieve all measurement results. It is saved with the extension 
«.Lts».

– The second file is a ASCII file using tabulations to separate values. 
It is saved with the extension «.txt» and can be opened by the 4000 
Platform via the Web Brrowser. It has been designed to be used with 
a spreadsheet program on a PC where it allows to retrieve all 
measurement results and format them in a nice customized table. 

Loading results In order to load the results of a measurement, select a file  with the 
extension «.Lts» in the file explorer (see the chapter «File management» 
in the user manual for «8100 modules series»), click on Load then View 
trace. 

The LTS tab is displayed with the loaded results in the table.
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6

Several desktop applications are provided to you, thanks to the integra-
tion of free software released under the free licences (GPL, LGPL, BSB 
or other). Their purpose is to bring more functionality to the 4000 Plat-
form. JDSU doesn’t provide any warranty or support regarding 
these free software.

To access desktop applications, press the button HOME, and the soft key 
App’s.

The topics discussed in this chapter are as follows:

– "Navigation and text edition in the Application pages" on page 76

– "PDF viewer" on page 78

– "Web browser" on page 80

– "Text Editor" on page 85

– "Calculator" on page 86

– "VNC Viewer" on page 87

– "Calendar" on page 89

– "Contacts" on page 99

– "eMail Application" on page 102

– "Wireshark Application" on page 112

– "File Explorer" on page 114
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Navigation and text edition in the Application pages

Navigating into
an application

page

Once one of the seven applications is selected, the corresponding page 
opens. Whatever is the page, different methods can be used to navigate 
in the screen and select one text field, one button...

With VNC, touchscreen or mouse connected to one USB port of the 
4000 Platform:

The easiest way to navigate is to directly click, with mouse or stylus for 
touchscreen, on one text field / button to enter text / activate the button.

With the 4000 Platform keys:

When you can only use the Platform keys to navigate into a page, several 
methods can be used:

– You can use the direction keys to reach a text field / a button one 
after the other, by successive presses.

– You can, when they are available, press the menu key Cursor until 
the wished text field / button is active, and then press Select to 
select it.

– Press simultaneously SHIFT +  to use the cursor on the screen 
and move it until the text field / button wished. Once cursor correctly 
positionned, press simultaneously SHIFT + ENTER keys to validate 
the selection.

Full Screen mode

In order to easily navigate in an application page, you can modify the 
page display by using a full screen mode.

1 To display the open page in full screen mode, onto the 4000 Plat-
form, press simultaneously SHIFT + HOME keys.

This mode will automatically widen the page, and hide the menu 
keys on the right of the screen.

Once the full screen mode, press back simultaneously SHIFT + HOME 
key to return to the «normal» display mode, with menu keys on the right 
of the screen.

Entering text Some pages from the applications menu require to enter text, number...
Five ways can be used to enter text
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1 Enter text using an external keyboard which is connected to the 
4000 Platform via the USB port or using an external keyboard of a 
PC connected to the Platform.

2 Enter text using the keyboard of the Application

a Select Keyboard on the key 

A keyboard is displayed  on the lower part of the screen

b Use the arrow keys or the touchscreen to enter the text.

3 Enter manually the text when a touch screen is used.

a Select Writing on the key 

b Write the letter manually, using the stylus for touch screen

You can click on Train, in order to draw each character on its cell. 
This allow to store the characters with your writing characteristics, in 
order to get the good letters when writing with the stylus.

4 Enter text using the numeric keypad onto the Platform. To enter a 
character, push as many times as necessary on the corresponding 
button. The characters available for a button are displayed on the 
lower left part of the screen (see "Numeric keypad on the 4000 Plat-
form" on page 27).

Example: to enter the letter «b» push the key «2» twice 

5 Press simultaneously SHIFT +  to position the cursor on the 
character wished and press simultaneously on SHIFT + ENTER to 
validate and enter the character in the text zone.

Specific keys and shortcuts:

Key «1»

– Press key «1» to enter specific characters: 

Fig. 36 Keyboard of the Text Editor
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– Pushing SHIFT + «1» keys allows to select all the text entered

Key «0»

– Pushing once the key «0» allows to enter a space:

– Pushing SHIFT + «0» keys allows to make a backspace and delete 
the letter on the left of the cursor.

The CANCEL button onto the 4000 Platform allows to delete the char-
acter preceeding the cursor.

Shift + *

Before entering text, you can also choose the kind of characters which 
must be entered. To do so, press simultaneously  SHIFT + * keys, until 
the good mode display: uppercase / lowercase / numeric.

PDF viewer
General information is provided in this chapter. Please refer to the button 

inside the PDF viewer to find the PDF reader version and a mini 
help on how to navigate into the pdf document.

The Space is selected

Do not press Cancel menu key if you wish to delete a character; 
if you click on Cancel menu key, you will leave the Edition dialog 
box.

Fig. 37 Characters edition mode
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Opening a PDF
document

The simplest way to open a pdf file is to press FILE. Select Explorer, look 
for your file and then select Load >Confirm Load to load the corre-
sponding file. The file opens automatically in the PDF viewer.

Another way used to open a pdf document is to press Home > App’s and 
select the PDF Reader icon. 

The PDF Reader opens but without document. To open a PDF 
document, click on the icon , and select a document in the file 
explorer dialog box.

Interacting with
a PDF

document

Once your document is open, you may browse through different pages 
very quickly, zoom to a particular level, find a special name or sentence, 
rotate the page... All these features are available via buttons on the 
screen. 

Fig. 38 PDF Help page

Fig. 39 PDF Viewer Graphical User Interface

Go to 10 pages less

Go to previous page

Go to next page

Rotate the page

About the PDF Viewer

Go to 10 pages more

Display the 
current page # Change zoom level Open file

Exit PDF viewer
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The buttons on the right are pressed using the functions keys of the 4000 
Platform, the touchscreen or via the mouse. The buttons on the bottom 
of the PDF viewer, may only be used with a mouse or a touchscreen.

Web browser

Starting the
web browser

To access this application, on the HOME page click on the soft key App’s.

In the Application screen, select Web Browser icon and press ENTER to 
open the web browser.

The web browser is launched.

Opening an
internet page

Once the Web Browser is displayed, you must enter the internet address.

1 Set the cursor in the address bar:

a Use the mouse connected via USB port on the 4000 Platform or 
the mouse of the PC if the screen is deported via VNC applica-
tion on the PC.

NOTE

You may scroll in all directions using the direction key pad of the 4000 
Platform or of an external keyboard, or by dragging the scroll bars 
with the mouse.

Fig. 40 Web Browser page
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b Click on the icon  so that it becomes . This allows to move 
the cursor toward the address bar, and to turn from  to .

2 Once the cursor set onto the address bar, enter the address:

a Using a keyboard connected to the 4000 Platform USB port or 
the keyboard of the PC with a deport of the screen via VNC, 
enter the entire address of the site to be opened.

b If none keyboard is available:

– click on the icoon  to display the virtual keyboard and enter 
the address using the buttons on the 4000 Platform or clicking 
directly on characters (see "Entering text" on page 76).

3 Push the ENTER hard key.

The page opens

If an error message is displayed in place of the internet page, verify 
the address you typed, or check the proxies configuration (see 
"Configuring the proxies" on page 82).

– During the loading of the page, the icon  is displayed. Once 
completed, the icon turns .

– The loading can be stopped at any time by clicking on .

Before validating the address, if the virtual keyboard is used, you 
must deselect the mouse option  (becomes ) .

Fig. 41 Internet page openend with the Web Browser

NOTE

Press SHIFT + HOME keys to display the page in full screen mode

Click once again on those keys to go back to the menu keys display.
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Configuring the
proxies

For the first use of the Web Browser, or if an error message is displayed 
instead of the internet page, check the configuration of the proxies.

1 Click on  in the tool bar to access the dialog box which allows 
to configure the proxies for the internet connection.

2 Select the kind of connection:

– Direct connection to the internet: option by default, to be selected 
if no proxy server is used    

– Auto-detect proxy settings for this network: select this option if 
you wish Firefox detects automatically the proxy parameters for your 
network. 

– Manual proxy configuration: select this option if you do not have a 
proxy address (URL). Ask your system administrator the ports 
names and numbers for servers on which the proxy is executed and 
enter the information in the appropriate fields.

– Automatic proxy configuration URL: if there is no file for the proxy 
configuration, ask the configuration URL to your system adminis-
trator and type it in this field.

3 Click on Ok to validate the configuration.

Navigation into
the Web
Browser

Once the Web Browser is open,  push the key   to display on the 
right of the screen, the buttons used to navigate.

Fig. 42 Configuration of the proxies

Icon Definition

Go to the previous or next page loaded

Refresh the actual page
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When a link is available in the page, the arrow cursor becomes a hand 
cursor.

Using the
bookmarks

Once a page is opened, you can apply it a bookmark, in order to get a 
shortcut toward this page.

Click on .

A new tools bar is displayed on the right of the screen.

Creating
bookmarks

Once the internet page for which a bookmark must be created is opened:

1 Click on the icon  to open the dialog box for bookmarks creation.

New icons are available on the right of the screen.

2 Click on the icon  to add a bookmark for the page displayed

3 Click on the icon  to edit the bookmark, and modify if necessary 
the name of the bookmark. Click on Ok to confirm the modification 
or Cancel to cancel the modifications.

Exit the Navigation menu

Icon Definition

Fig. 43 Creation of bookmarks
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– Click on  to open the page of the bookmark selected in the list

– Click on  to delete the selected bookmark from the list

– Click on  to exit the bookmark menu and go back to the Web 

Browser page.

Opening a PDF
document

PDF documents may be opened and read within the Web browser.

Please refer to "Navigation and text edition in the Application pages" on 
page 76 for more information about that application.

– When you click on a link toward a PDF file, a dialog box during 
loading is displayed.

– Once loading is completed, click on Ok to open the pdf file.

Click on the icon   to go back to the web browser.

Fig. 44 Bookmark edition

Fig. 45 Downloading a pdf file

NOTE

The web browser will open a PDF document, not a URL including a 
PDF file.

The PDF is also automatically saved on the disk of the 4000 Plat-
form.
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Leaving the
web browser

Depending on how long you want to leave the web browser and on your 
connection mode, you may:

– Leave the web browser running and switch to another task. To do 
this, click on the HOME button. 

You can see that the Web icon  remains, to indicate that the 
web application is still running in the background. Nevertheless, you 
have now a complete access to all the 4000 Platform functionalities.

To go back, you must select again the Web Browser in the App’s 
menu. The application will reopen much faster, and all your environ-
ment will be the same (last current page, possibilities to go back...)

– Quit the application using the Web browser application menu:  click 
on the key .

Text Editor
The Text Editor application allows to enter text on the 4000 Platform and 
save it into a txt file

Text Editor
page

To open the Text editor:

1 In the Home page, press the App’s key

2 In the Application screen, select the icon Text Editor.

The icon is framed in white

3 Press ENTER to validate the selection and open the Text Editor 
application.

Fig. 46 Text Editor application
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Once the text editor is open, enter text using the method you wish (see 
"Entering text" on page 76).

Saving the text
in a file

Once the text is entered, you can save it in a file onto the 4000 Platform.

1 Click on File > Save or Save as...

2 In the new dialog box, select the folder in which the file must be 
saved

3 Enter a name for the file with the file extension (.txt or .csv if it must 
be opened with the 4000 Platform).

4 Click on Ok to validate

The file is saved and still opened

– You can modify it and click on Save at any time

– If you modify the file and click on Save as....you can choose another 
folder and/or another name

Press  to exit the text editor and go back to the Applications page.

Press HOME to go back to the Home page, and keep the application 
active (the icon  is still displayed on the upper banner).

Calculator
A calculator can be displayed and used onto the 4000 Platform.

1 In the Home page, press the App’s key

Fig. 47 Save file

Select the folder

Enter file name
Save the file
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2 In the Application screen, select the icon Calculator.

The icon is framed in white

3 Press ENTER to validate the selection and open the Calculator

Press  to exit the Calculator and go back to the Application page.

Press HOME button to go back to the Home page, and keep the Calcu-
lator application active (the icon  is still displayed on the upper 
banner).

VNC Viewer
A VNC Viewer is available onto the 4000 Platform and allows to 
command an equipment onto the network.

1 In the Home page, press the App’s key

2 In the Application screen, select the icon VNC Viewer.

The icon is framed in white

3 Press ENTER to validate the selection and open the VNC viewer.

The screen displays a Connection dialog box

Fig. 48 Calculator
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4 Enter the VNC server address

5 If necessary, modify the options of the VNC server by clicking on the 
Options... button

The options dialog box is displayed

6 Once the parameters wished are selected, click on OK to apply the 
modification to the VNC Viewer

7 In the VNC Viewer Connection dialog box, click on OK to activate it.

The VNC screen is displayed.

Fig. 49 Connection screen to VNC Viewer

NOTE

When the VNC Viewer from the application menu is used, the icon  
is displayed in the upper banner.

Fig. 50 VNC Viewer: options
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Click on  to exit the VNC Viewer and go back to Applications page.

Press HOME key to reach the Home page, and keep the application 
active (icon  still displayed on the upper banner).

Calendar
The Application page also allows to use a calendar, in order to enter 
Notes, dates, events etc.

Display of the calendar

1 In the Application menu, select Calendar icon using direction keys

2 Press Enter to open the Calendar application

Fig. 51 VNC Viewer screen (example in full screen mode)

Fig. 52 Calendar
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The page displays by default the calendar for the current date, in the daily 
mode.

Create an event
in the calendar

Once the Calendar application is active, whatever is the View displayed, 
you can add events to the calendar.

1 To enter a new event, click on New button (or use the File menu and 
select New).

2 The Event dialog box opens

3 Enter the necessary information for this event on each available tab:

– Event tab: enter the event description, date and time (see Figure 53 
on page 90)

– Details tab: The elements countained in this tab allow to define the 
location of the event, to save this event into a category (see “Create 
a category” page 91) and to enter a full description of it.

– Alarm tab; this tab allows to activate an alarm for this event. This 
alarm will be activated some minutes before the event start time 
(from 1 minute).

– Recurrence tab; this tab allows to assign a recurrence to the event; 
it will allow to recall the event as long as necessary (daily, monthly 
...),

4 Once all the necessary parameters have been entered for an event, 
click on Save to save it in the calendar.

– The event will be underlined in the calendar or in the agenda.

The today date corresponds to the date entered in the System 
Settings page.

Fig. 53 Calendar: create a new event

Enter a general 
description of the 
event

Select the start & end time 
of the event Enter the start & end 

date of the event 
using the calendar

Save the event

Select the calendar to which 
this event belongs (see 
“Create a new calendar” 
page 91)

Select this parameter if the 
event lasts all the day
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Create a
category

The events saved in the calendar can be defined in a specific category 
you can create.

To do so:

1 In the Tool Menu, select Category

2 The dialog box opens

3 Enter a name for this category

4 Select a predefined color for this category, or click on to 
define a new color.

5 Click on OK to validate the creation of the category

This choice of colour will allow to distinguish the events according to the 
category to which they belong.

Create a new
calendar

You can also create one or several other calendars than the one defined 
by default in the application. This calendar will be specific and will allow 
to insert specific events.

To create a new calendar:

1 In the Calendar application, click on Menu key and select Tools > 
Calendars

The Calendars page opens

Fig. 54 Create a category
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2 To add a new calendar to the existing ones, click on the icon .

A new box opens

3 Enter the Calendar Title, which will appear in the View page.

4 You can also give a description of this calendar (for which use it has 
been created...)

5 You can select a parent of this calendar; another calendar which will 
be used as model for this one.

6 Modify if necessary the colour of the calendar clicking on the colour 
displayed, to open the colour selector box

7 The colour will be applied for all the events belonging to this 
calendar.

Fig. 55 View existing Calendars

Fig. 56 Create a new calendar
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8 Click on OK to validate the new colour

9 Select the type of calendar:

– Local:

– Subscribe: select this parameter in order to receive other calen-
dars from other users.

If Subscribe has been selected, enter the URL, Username and 
Password to access the calendar. Enter also the recurrence of the 
update for this calendar (x times per hour / day / week / month / 
year).

– Publish: select this parameters in order to publish the calendar, 
and allow other users to visualize it.

If Publish has been selected, enter the URL, Username and 
Password to access the calendar.

10 In the New calendar box, click on OK once all parameters are vali-
dated.

The screen displays the list of calendars, including the one just 
created.

If this is not the case, click on the icon .

Fig. 57 Select colour
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Click  to Edit the calendar (see Figure 56).

Click on  to delete the calendar and reassign if necessary the events to 
another one.

The different
views of the

calendar

The calendar application allows to display different information on the 
screen.

Daily, weekly and
monthly calendar

Once the calendar application is activated, the page displays by default 
the daily calendar, with the today date.

To modify the view of the calendar, you can:

– Click as many times as necessary on the key View to display 
successively a weekly calendar, a monthly calendar, an agenda, the 
existing alarms or go back to the today calendar.

or

– Use the tool bar or the View menu and select the view to be 
displayed:

– : weekly calendar

Fig. 58 New calendar in the list

The today date correponds to the date entered in the System 
Settings page.
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– : monthly calendar

– : today calendar (this is the same display as a daily 
calendar)

– You can choose the date for which the calendar will be 
displayed, by using the following fields: .

Fig. 59 Example of weekly calendar

Fig. 60 Example of monthly calendar

Fig. 61
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Once the date is entered, when you click on the weekly or monthly 
icon, the calendar will be displayed for the week / month to which 
the date belongs.

Agenda In the View menu, or on the toolbar, you can choose to display a agenda, 
which will display a list of all the events registered for a defiend period.

1 Click on the icon  of the toolbar

or

Select Agenda in the View menu

or

Click as many times as necessary on the VIEW key to reach the 
agenda screen

2 Once selected, you will have to enter the period you want to display 
on screen

For example, in the Figure 62, the agenda displays the events regis-
tered for 3 months, starting from the current date.

Event menu Whatever is the kind of calendar displayed, you can click on an event of 
the calendar, which will open a menu with different available actions:

Fig. 62 View Agenda

NOTE

The agenda for the period selected can also be displayed in sidebar 
(see “Sidebar” on page 98).
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– Edit: allows to edit the event selected, and if necessary to modify its 
parameters.

– Delete: allows to delete the event selected. A confirmation will be 
asked.

– Save: allows to save the event in a .ics format onto the disk of the 
4000 Platform, or on the usb key connected to the equipment, if any,

– Move to Calendar...: allows to modify the calendar to which the 
event belongs. Click to open a sub-menu with all the calendars 
available (see “Create a new calendar” on page 91).

– Calendar: allows to edit, save in a .ics format, delete, show exclu-
sively or hide the calendar to which the events belong.

Alarms Once the alarms of past events have gone off, it is possible to display a 
list of those alarms.

1 Click on the icon  of the toolbar or select Alarm in theTool 
menu or click on the alarms menu key .

A summary of the Alarms which have gone off displays.

You can click on SHOW EVENT to display the event in alarm.

Click on ACKNOWLEDGE to remove the alarm for this event

Fig. 63 Event menu

Fig. 64 Alarms
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Click on ACKNOWLEDGE ALL at the bottom of the screen to remove 
all the alarms of the screen.

Click on DISMISS to go back to the calendar view. In this case, if an 
reccurence has been defined for the alarms, the Alarms screen will 
display back each time a reccurence occurs.

Sidebar A sidebar can be configured, to display more or less information on the 
calendar screen. Three elements can be displayed on the sidebar:

– Calendar: this displays a calendar of the month activated.

– Calendar Selector (displayed by default when application is 
launched): this display a list of the calendars available, and allows to 
show or hide the events belonging to the calendar(s)

– Agenda (displayed by default when application is launched): display 
a list of all the events saved for a defined period (see “Agenda” on 
page 99 to modify a period for the agenda).

To activate one or several sidebar(s):

1 In the View menu, activate Sidebar

2 Select Calendar and/or Calendar Selector and/or Agenda to 
display the corresponding sidebar on the right of the calendar.

If a Calendar is deselected in the Calendar selector sidebar, then 
the events belonging to it will not be displayed either in the 
calendar nor in the agenda sidebar.

Fig. 65 Calendar with all sidebars

Calendar 
sidebar

Calendar 
selector 
sidebar

Agenda 
sidebar
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Calendar

– Once this calendar is displayed, you can click on one date to display 
the corresponding calendar. 

The display will kept the calendar mode selected (daily / weekly / 
monthly) and then will display the day, week or month to which the 
date selected belongs to.

– The dates in bold are those for which one or several events have 
been defined.

– The sidebar will not be displayed if a monthly calendar is activated.

– Click on the white dates to reach the previous or next month (or 
select a month on the upper toolbar).

Calendar selector

– Select/deselect a calendar to display/hide the events belonging to it.

If a calendar is deselected, this will automatically remove the events 
defined for this calendar from the Agenda sidebar and from the 
calendar on the left of the screen.

Agenda

– The agenda displays the events with the color corresponding to the 
calendar they belong to.

– Click on one event to display it in the daily calendar.

Exiting from the
calendar

application

– Click on  to exit the Calendar application and go back to Appli-
cations page.

Or

Press HOME key to reach the Home page, and keep the application 
active (icon  still displayed on the upper banner).

Contacts
The Contacts application, available in the App’s screen, allows to add 
contacts for sending e-mail.

Add a contact 1 In the Application menu, select Contacts icon using direction keys

2 Press Enter to open the Contacts application

3 To enter a new contact, click on the New menu key
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A new dialog box displays

4 In the tab Personal, enter general information concerning the new 
contact (Name / Birthday date / Summary)

Click on the blank square in order to select an image on the explorer 
and associate it to the contact.

5 The Details button opens a new dialog box allowing to select details 
about the contact: Title (Dr, Mss, Mr, Dr...) / First name / Middle 
name / Last name / Suffix (Jr., Esq., Sr., I, II...)

6 In the tab Location, define the contact personal and professional 
addresses and phone numbers, as well as its mail addresses.

7 In the Notes tab, you can add information about the contact

8 In the Categories tab, click on the Categories button to define the 
contact to a existing category; or create a new one and link the 
contact to it.

Fig. 66 New Contact

NOTE

You can select the Keyboard or Writing function to enter text (see 
"Entering text" on page 76).

If a category is modified / added / deleted via the eMail application, it 
will be automatically added / deleted in the Calendar application, and 
vice versa..

NOTE

The categories available are the same as the calendar categories 
available in the Calendar application (see "Create a category" on 
page 91)
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9 Once all the necessary information have been entered, click on 
SAVE to store the contact in the application.

10 You can use the menu Categories at the bottom of the screen to 
filter the contacts according to the category they belong to.

11 Use the Find field to quickly retrieve a contact entering its name, 
address...

or

Click on the Find button to easily find a contact.

12 Click on the contact mail address to directly open the eMail applica-
tion and send him a message by e-mail 

or

Click on the Email button (see "eMail Application" on page 102).

13 Click on the Backup button to save the contacts in a xml file.

14 Double click on the contact name on the left list to edit and modify if 
necessary the contact information.

15 Click on  to exit the Contacts application and go back to Appli-
cations page.

Or

Press HOME key to reach the Home page, and keep the application 
active (icon  still displayed on the upper banner).

Fig. 67 New contact

Indication of the category the contact belongs to

NOTE

When a contact belongs to a category, a circle with the colour corre-
sponding to the category is displayed next to its name.
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eMail Application
The eMail application allows to send and receive mail onto the 4000 Plat-
form.

To open the eMail application:

1 In the Home page, click on the App’s button

2 In the Application page, select the icon eMail using direction keys

The icon is white framed.

3 Click on ENTER key to open the Mail application page.

The following screen is opened by default

Configuring an
e-mail account

In order to be able to send and receive e-mail onto the 4000 Platform, 
you must first create and configure the user account.

1 Once the  Index page is displayed, click on one the Basic parameter 
to start configuration (see step 3). In this case, the Account titled 
Example-Account in the Account page will be modified (see 
Figure 69 on page 103)

or

Click on Cancel to reach the Folder List page and click on 
Accounts  on the upper part of the screen.

A new screen displays with one account visible, used as example.

Fig. 68 eMail: Folder List page
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2 Click on New button to create a new account (or on Edit if an 
existing account must be modified).

The Page Index displays

3 Click on Basic line to display the Basic screen and enter general 
information on the account.

Enter the necessary information concerning the description of the 
account: 

– Name of account: enter the name for the new account.

– Select Set as Default to define this new account as the default one.

– Personal Information

In this box, enter the full name of the account (optional), its mail 
address (mandatory) and the organization he belongs to (optional).

– Server Information

Fig. 69 Account page

Fig. 70 Mail Account - Basic parameters
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Select the Protocol to be used for the account configuration:

– POP3: Post Office Protocole

– IMAP4: Internet Message Access Protocol

– News (NNTP): Network News Transfer Protocol

– Local mbox file

– None (SMTP only): Simple Mail Transfer Protocol

According to the Protocol selected, the parameters available are 
different.

POP3 and IMAP4 Protocols

– Server for receiving: enter the server address for the received 
messages.

– SMTP server (send): enter the server address for the sent 
messages.

– User ID: enter the user idenfier for accessing to the server

– Password: enter the password for accessing to the server

News (NNTP) Protocol

– News Server: enter the server address for the received messages

– SMTP server (send): enter the server address for the sent 
messages.

– This server requires authentication: if the server needs authetica-
tion, select this parameter to activate if necessary the following one, 
and to enter a user identifer and password.

– Authenticate on connect: this parameter can be activate exclu-
sively when the following one is selected.

– User ID: enter the user idenfier for accessing to the server

– Password: enter the password for accessing to the server

Local Mbox File Protocol

– Local Mailbox: Enter the name of your local mail box

– SMTP server (send): enter the server address for messages sent.

CAUTION
Once the Protocol is selected, and the Apply key is pressed, if 
you go back to the Basic page, you cannot modify the Protocol 
previously defined.
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– Use mail command rather than SMTP server: select this param-
eter deactivate the previous one and activate the following.

– command to send mails

None (SMTP only) Protocol

– SMTP server (send): use this protocol in order to exclusively send 
mails and not to receive them.

Once the Basic Page is completed, click on APPLY to validate this new 
account.

4 In the page index, click on Receive and define the parameters for 
the received messages.

In the upper box (POP3 in the figure), define the parameters available, 
which are different according to the protocol defined in the Basic page 
(see page 103).

POP3

– Use secure authentication (APOP)

– Remove message on server when received: allows to delete the 
messages from server after a period, which will be  defined in the 
following parameter, activated once this one is selected.

Remove after x days: enter the number of days after which 
messages will be removed from the server.

Fig. 71 Mail Account - Receive parameters

NOTE

If the protocol None (SMTP) is selected in the Basic page, the 
Receive page is inactive.
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– Receive size limit x KB: enter if necessary the maximum size 
authorized for the revceived e-mail.

– Default inbox: if necessary, select another directory in which 
received e-mail will be stored, clicking on Browse.

IMAP4

– Authentication method: select in the list, the method to be used: 
Automatic / Login / CRAM-MD5 / ANONYMOUS / GSSAPI / 
DIGEST-MDS.

– IMAP server directory (usually empty): 

– Show subscribed folders only

– Bandwidth-efficient mode (prevents retrieving remote tags): 

NEWS (NNTP)

– Maximum number of articles to download:

Local Mbox file

– Default inbox

The following three parameters are available for all protocols:

– Filter messages on receiving: selecting this parameter allows to 
«sort» the e-mail when received.

– Allow filtering using plugins on receiving: this parameter can be 
activated exclusively if the previous one is selected, and allows to 
filter messages using plug-ins.

– ’Get Mail’ checks for new messages on this account: this 
parameter allows to check automatically the messages when Get 
Mail button is activated.

Click on Apply to validate the Receive parameters.

5 On the Page index, click on Send and define the parameters for the 
messages sent.
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In the Header zone:

– Select Generate Message-Id (not available with IMAP4 Protocol)

– Select Add user defined header to insert a specific header for all 
messages, and click on EDIT to select the file and configure the 
header.

In the Authentication zone:

– Select SMTP Authentication (SMTP AUTH) if you wish to add an 
authentication to the mail access.

Once selected, you can choose the authentication method to be 
used: Automatic / PLAIN / LOGIN / CRAM-MD5

You can also enter a User ID and Password for authentification 
when sending messages.

Select Authentication with POP3 before sending if the message must 
be authenticated by a POP3 server before sending.

Click on Apply to validate the Send parameters.

6 On the Page index, click on Compose and define the parameters 
for the composition of the messages.

Fig. 72 Mail Account - Send parameters

NOTE

If those two fields are empty, the same user ID and password as the 
Receive parameters will be used.
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In the Signature zone:

– Insert signature automatically: select this parameter in order to 
insert a signature at the end of all the messages sent.

– Signature separator: modify, if necessary, the signature separator 
(-- by default)

– Select if the signature is available in a file or with a command output.

– In the Automatically set the following addresses zone, enter the 
addresses of the contact(s) to which a copy or a reply will be sent for 
all messages.

Click on Apply to validate the Compose parameters.

7 On the Page index, click on Templates

The page allows to enter a text which can be used as template for the 
messages composed / replied / forwarded (select the correct tab).

Fig. 73 Mail Account - Compose parameters

Fig. 74 Mail Account - Template parameters
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– Select Use template when composing new messages in order to 
automatically get the message from the template into the messages 
sent / replied / forwarded.

– Click on Apply to validate the Template parameters.

8 On the Page index, click on Advanced

– In the upper zone, if necessary, select the port wished and define its 
number.

– In the Folder zone, modify the directory in which each kind of 
message (sent / queued / draft / deleted) will be stored.

– Click on Apply to validate the Advanced parameters.

9 Once all parameters are defined, click on Close to go back to the list 
of accounts.

The new account has been automatically added.

Fig. 75 Mail Account - Advanced parameters

Fig. 76 New Account

New 
account
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: Modify the default account by selecting a new one and 
clicking.on Set as default account.

The account set by default is displayed in bold.

: Click on New to create a new account.

: Select an account and click on Edit to modify the parameters.

: Select an account and click on Delete to remove the account.

: Select an account and click on Copy to create a new account, 
identical to the one selected (and click on Edit once the new account is 
selected to modify the parameters).

: Click on Up or Down to modify the position of the account in the 
list.

: Click on Close to close the account page and reach the E-mail 
page. 

Sending an e-
mail

Once the account has been correctly configured. you can send e-mail 
using the 4000 Platform.

1 In the account page, select the account to be used for sending 
message (icon ).

2 Click on Close to reach the Folder List page (see Figure 68 on 
page 102).

3 Click on Compose   to create a new message

or

In the Folder list, click on Address Book and select the contact to 
which an e-mail must be sent, and click on the Email button (see 
Figure 67 on page 101); or directly click on the contact e-mail 
address.

The screen displays a page to compose e-mail, in which the sender 
address is the one corresponding to the account previously 
selected.
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4 On line To:, enter the recipient e-mail address (if the button 
Compose is used).

If the key Address book has been used, the recipient name and 
address is already defined.

5 On line Subject, enter a subject for the mail

6 Enter the text in the empty field

7 Click on  to send the e-mail

Before sending the message, several actions can be performed:

– To attach a file to the message, click on the button  and select 
the file in the dialog box opened.

– To insert a file into the message (an image...), click on  and 
select the file into the dialog box opened.

– Click on  to close the current opened message and choose to 
discard it or save it in the drafts folder.

– Click on  to save the message in the Draft folder.

– Click on  to save the message in the Queue folder and send 
it later.

Once the message has been sent to the recipient(s), the screen returns 
to folder list display (see Figure 68 on page 102).

You can click on one folder to display its contents.

Fig. 77 Composing an e-mail
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On this screen you can also:

– : Click to refresh the display and display the mail recently 
received.

– : Click to reply to the message sender.

– : Click to transfer the message to other recipients.

– : Click to delete the selected file from the current folder and 
transfer it to the Trash folder.

– : Click to select the next file in the list.

Exiting from the
eMail

application

– Click on  to exit the eMail application and go back to Applica-
tions page.

Or

Press HOME key to reach the Home page, and keep the application 
active (icon  still displayed on the upper banner).

Wireshark Application
Wireshark is a Protocol Analyzer.

The application set onto the MTS / T-BERD 4000 allows to open VoIP 
packet capture files.

Fig. 78 Folder «Inbox» open
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Opening the
Wireshark

application

1 In the Application menu, select Wireshark icon using direction 
keys

2 Press ENTER to open the Wireshark application

The following screen displays

Opening VoIP
packet capture

files via
Wireshark

Once the application is open, you can load a file to be displayed via Wire-
shark.

1 Press Open key

A browser displays

2 Select the directory in which the VoIP packet capture file has been 
stored, and press ENTER.

3 Select the file in the list (extension .pcap).

Fig. 79 Wireshark page

Fig. 80 Selecting the VoIP packet capture file

Description 
of the 
selected file
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4 Press Open to lad the file in Wireshark application.

A new box opens during loading, indicating the remaining time of 
loading.

5 Once fully loaded, the file contents displays.

Exiting from the
Wireshark

application

– Click on  to exit the application and go back to Application 
page.

Or

Press HOME key to reach the Home page, and keep the application 
active (icon  still activated on the Application page).

File Explorer
This key allows to directly open the MTS/T-BERD 4000 explorer, where 
all the files are stored (traces, pdf files ...).

The explanation about the explorer are available in Chapter 11 “File 
management” on page 163.

Fig. 81 VoIP packet capture file openend in Wireshark

Click on one 
tab to sort the 
list according 
to this tab
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7

The Bluetooth interface allows file transfers. 

It is an option that must be installed at the factory.

The topics discussed in this chapter are as follows:

– "Setting up a Bluetooth connection" on page 116

– "Removing the Pairing" on page 117

The product is approved in accordance to R&TTE directive 
concerning transmitter module marked by CE0678. It is 
manufactured by MITSUMI and it is an OEM product.
This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) this device may not 
cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause 
undesired operation . This device contains FCC-ID: POOWML-
C40.
User Manual 770000002/04 115



Chapter 7 Bluetooth option
Setting up a Bluetooth connection
Setting up a Bluetooth connection
The Bluetooth option allows file transfers between the 4000 Platform and 
another device

1 On the Home page, press System Settings key

2 Under I/O interfaces, select Bluetooth > Enable

The icon  is displayed on the upper banner of the screen

3 Push the Bluetooth Pairing key 

The Paired Bluetooth screen appears

4 Do one of the following:

Press the Become Pairable soft key to wait for another device to 
initiate the connection to the 4000.

or

If the desired device is not displayed on the screen, or if no devices 
are detected, press the Search Devices soft key.

The 4000 Platform is searching for the devices which could be used 
via Bluetooth with the equipment.

A baragraph is displayed during research  

Once the research is completed, a list of the available devices is 
displayed, with the level of detection of the 4000 Platform 

REMINDER
You may need to activate bluetooth on the other device to allow 
pairing.

Fig. 82 List of devices found
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a Using the direction keys  and , select the device to be 
paired with the Platform

It will be underlined in blue

b Push the Pair key to connect the device to the Platform

5 If prompted, enter a pairing code. The code must be identical on the 
4000 and the device.

6 Once the bluetooth device and the Platform are paired, a screen is 
displayed with the description of the device

The icon has a blue background when paired with a device , 
versus no background when not paired .

You can now go to the file explorer and transfer files from the 4000 Plat-
form toward the bluetooth device and vice versa (see “Sending files by 
Bluetooth” on page 175):

If you haven't already done so, enable file export using Bluetooth by 
doing the following:

1 Press the HOME key and then press the System Settings soft key.

2 Use the down arrow  to move to the I/O Interfaces settings and 
then to File export.

3 Select Bluetooth and then exit the menu.

Removing the Pairing
1 To remove the pairing between the two equipments, in the System 

Settings page, push the Bluetooth Pairing key

Fig. 83 Device paired with Platform
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2 In the screen displayed, push the Remove pairing key

The icon on the upper banner of the screen becomes  showing the 
Platform is no more connected to a bluetooth device, but the Bluetooth 
option is still active.

To deactivate the bluetooth onto the Platform, go in the System Settings 
page, and under I/O Interfaces, select Disable on the Bluetooth line.
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8

This chapter provides task-based instructions for using the MTS/T-BERD 
4000 wireless testing features. Topics discussed in this chapter include 
the following:

– “About 802.11 testing” on page 120

– “Wireless testing” on page 120

– "802.11 wireless results" on page 122

This product is approved in accordance to R&TTE directive 
concerning transmitter module marked by CE0560. It is 
manufactured by QCOM TECHNOLOGY and it is an OEM 
product.
This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) this device may not 
cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause 
undesired operation. This device contains FCC-ID: RUJ-
LR802UKG – IC: 4654A-LR802UKG.
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About 802.11 testing
In IEEE 802.11 mode, you can use the MTS/T-BERD 4000 to emulate a 
wireless PC or laptop and connect to a wireless network. After 
connecting to the network, you can then use the data tests as well as the 
VoIP and Video features.

To select IEEE 802.11 mode

– From the Home screen, highlight IEEE 802.11, and then press the 
ENTER key.

The 802.11 tab appears.

Wireless testing
The wireless test involves the following steps:

– Specifying test settings

– Connecting to the line

– Performing tests

– Viewing results

To run a wireless test

1 To specify test settings, do the following:

a From the 802.11 tab, press the SETUP key.

The 802.11 setup page appears.

Configuring the settings can be done one of two ways:

– Press a number on the key pad that corresponds to the setting 
you want to configure.

– Use the arrow keys to highlight the setting you want to change, 
and then press the ENTER key. Press the CANCEL key to exit a 
menu. 

b Specify the settings. 

The following table describes the settings.

NOTE

The 802.11 wireless feature is an option that requires an add-on 
board. VoIP and IP Video are also options, but only require software.
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2 To connect to the line, press the RESULTS key to return to the 
802.11 Summary screen. 

The MTS/T-BERD 4000 will scan for the SSID that you specified, 
and attempt to connect to it.

3 To view another result category, do one of the following:

a Press the right or left arrow to cycle through the menus.

b Press the View soft key, and then select a category.

4 After successfully connecting to the wireless network, run your test.

For Data tests, VoIP tests, and IPVideo tests, see MTS 4000 Triple 
Play Testing User’s Guide.

Setting Description

SSID Press the ENTER key to scan for service 
set identifiers (SSIDs) in the area. If 
found, select the desired network to con-
nect to. To enter a custom SSID, press 
the Custom SSID soft key and use the 
keypad to enter the SSID name.

Encryption Type Select the type of encryption.

None, WEP40, WEP104, WPA/WPA2 
(Auto), WPA Only, WPA2 Only

WPA/WPA2 (Auto) will cause the unit to 
use WPA2 if available and then fall back 
to WPA

WPA1/2 PSK Enter the pre-shared key (PSK) to use for 
WPA or WPA2.

WEP40 or 
WEP104 Key

Enter the static WEP key to use.

Region Select your region: US, Japan, EU. The 
channels that are available will change 
based on the region.

NOTE: Changing the region will restart 
the application. If you are running a test 
this will cause errors. Only change the 
region before a test.
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802.11 wireless results
The following result categories are available in the 802.11 application:

– Summary

– BSS Properties

– 802.11 Frames

– Networks In Range

– Event Log

You can view many additional results by pressing the arrow keys or use 
the View soft key and then select another category.

The following sections describe the results in each category.

802.11
Summary

results

This default results screen provides a summary of the most frequently 
used test results. Table 2 describes the 802.11 summary results.

Fig. 84 Summary result page
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Table 2 802.11 summary results

Result Definition

Circuit diagram Located in the top area of the screen, 
shows a graphic indication of the circuit, 
including the link status. The status will be 
one of the following:

Idle – 802.11 stopped, unit may be scan-
ning depending on Idle Scan option in net-
works screen

Scanning – Scanning for the SSID config-
ured in setup

Associating – associating to a BSS

Associated – Associated to a BSS. How-
ever, the link is not fully up yet.

WPA Handshake – Completing the WPA 
handshake to set up encryption

Link up – Link is fully up.

SSID The SSID selected in the Setup menu. 
This is the network that we are connected 
to (or attempting to connect to).

Link status Located on the left of the screen, indicates 
whether the link is up or down.

BSSID The Basic Service Set Identifier is an iden-
tifier that represents a single 802.11 cell 
(similar to a MAC address).

Channel The 802.11b/g channel the particular BSS 
is operating in.

Pairwise Encryp-
tion

The encryption used for frames sent 
between the MTS/T-BERD 4000 and the 
access point.

Data Bytes Total bytes received and transmitted.

Data Frames Total frames received and transmitted.

Errors Total errors received or transmitted.

Last Data Rate The data rate most recently achieved.

Signal Strength The dB level of the signal.
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BSS Properties This screen reports the properties of the basic service set (BSS). Table 3 
describes the BSS Properties results.

Fig. 85 BBS Properties

Table 3 BBS Properties results

Result Definition

SSID The SSID selected in the Setup menu. This 
is the network that we are connected to (or 
attempting to connect to).

BSS The Basic Service Set Identifier is an iden-
tifier that represents a single 802.11 cell 
(similar to a MAC address).

Channel The 802.11b/g channel the particular BSS 
is operating in.

Frequency The frequency of the 802.11b/g channel in 
use.

Mode The 802.11 mode - whether it is managed 
or not.

Slot Time The slot time in use for this BSS - short or 
long. Short slot times typically provide bet-
ter performance.
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Preamble The preamble type in use by this BSS - 
short & long or long only. Short preambles 
can increase performance but can reduce 
frame detection in noisy environments.

QoS BSS Whether the BSS supports any quality of 
service controls. A BSS with QoS will gen-
erally handle tasks such as VoIP better.

APSD Whether the BSS supports Automatic 
Power Save Delivery. APSD is a method to 
allow 802.11 devices to consume very little 
power.

Protection Whether the BSS requires CTS protection 
when transmitting. CTS-to-self is a mecha-
nism used to protect 802.11b devices oper-
ating on 802.11g networks.

AID The association identifier of the MTS/T-
BERD 4000 in this BSS.

Pairwise Cipher The cipher (encryption method) used for 
frames sent between the MTS/T-BERD 
4000 and the access point.

Groupwise 
Cipher

The cipher (encryption method) used for 
frames sent from the access point to all 
devices associated with it.

Protocol The security key protocol in use. This is N/
A when using no security or WEP. For WPA 
modes, it will be either WPA or WPA2 
depending on what was negotiated.

Key Mgmt The key management system used by the 
key protocol. For WPA/WPA2, it will be 
PSK; for non-WPA encryption modes, it will 
be None.

Speeds The speeds supported by the BSS. The 
bold speeds are speeds that all associated 
devices must support to join the BSS.

Table 3 BBS Properties results

Result Definition
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Errors This screen reports error statistics. Table 4 describes the 802.11 Errors 
results.

Fig. 86 Erros Results page

Table 4 Errors results

Result Definition

RX False Alarms/
Second

A graphical representation of the percent-
age of false alarms per second received in 
the last 120 seconds. This is useful in 
noisy environments to show interference.

FCS Errors Count of frame check sequence (FCS) 
errors received in the last second and 
total received. Frames with FCS errors 
have corrupted payload so they are 
dropped.

PLCP Errors Count of physical layer convergence pro-
cedure (PLCP) errors received in the last 
second and total received. Frames with 
PLCP errors have a corrupted header so 
they are dropped.

RX False Alarms Count of false alarms received in the last 
second and total received. A false alarm is 
when the radio is triggered to enter the 
receive state by RF energy but then real-
izes that there is no 802.11 traffic. This 
result is indicative of non-802.11 interfer-
ence or severely corrupted 802.11 frames.
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802.11 Frames This screen reports frame statistics. Table 4 describes the 802.11 Frame 
statistics.

Long RX False 
Alarms

Count of long false alarms received in the 
last second and total received. These are 
false alarms that last an unusually long 
time. Long RX False Alarms are not 
included in the RX False Alarm result.

TX No Retries Count of bits that transmitted successfully 
with no TX retries.

TX One Retry Count of bits that transmitted successfully 
with only one retry.

TX Multiple 
Retries

Count of bits that transmitted successfully 
with multiple TX retries.

Tx Failed Count of bits that were attempted to be 
transmitted but failed. This doesn’t always 
mean the frame was lost, but the MTS/T-
BERD 4000 did not receive an acknowl-
edgement.

Table 4 Errors results

Result Definition

Fig. 87 Frames results
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Networks in
Range

This screen reports any 802.11 networks within range. The SSID, BSSID, 
signal strength, channel number and frequency, and the encryption in 
use are listed. The list can be sorted by SSID or signal strength.

The list updates in the follow situations:

– The Scan soft key is pressed. Using the Scan soft key while associ-
ated to an access point could cause data disruption.

Result Definition

RX Unicast Data Number of data frames or bytes received 
whose payload is unicast and the last rate 
for this frame type. If no frames have been 
received of this type, it will say “waiting”.

RX Multicast Data Number of data frames or bytes received 
whose payload is multicast and the last 
rate for this frame type. 

RX Unicast Mgmt Number of management frames or bytes 
received whose payload is unicast and the 
last rate for this frame type. 

RX Multicast 
Mgmt

Number of management frames or bytes 
received whose payload is multicast and 
the last rate for this frame type.

Tx Unicast Data Number of data frames or bytes sent with 
unicast payloads and the last rate for this 
frame type.

TX Multicast Data Number of data frames or bytes sent with 
multicast payloads and the last rate for 
this frame type.

Tx Mgmt Number of management frames or bytes 
sent and the last rate for this frame type.

BSSID The Basic Service Set Identifier is an iden-
tifier that represents a single 802.11 cell 
(similar to a MAC address).

AID The association identifier of the MTS/T-
BERD 4000 in this BSS.
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– When the state is Idle and the Idle Scan soft key is set to On. This 
option means “scan while idle” – the unit updates the network list 
every 2 seconds. This is useful for walking around and checking out 
networks.

– During normal operation while trying to associate with an access 
point, the network list may be updated.

The Last Scan Time indicates when the previous scan occurred and 
gives an indicator how old the list is.

Event log This category provides a running log of significant wireless events and 
errors.

Fig. 88 Networks in range

Fig. 89 Events log
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9

This chapter provides task-based instructions for using the MTS/T-BERD 
4000 Ethernet TE testing features. Topics discussed in this chapter 
include the following:

– “About Ethernet TE testing” on page 132

– “Specifying test settings” on page 132

– “Connecting to the line” on page 136

– “Running a cable test” on page 136

– “Viewing results” on page 137

– “Ethernet TE results” on page 137

– “Web browser” on page 141
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About Ethernet TE testing
In Ethernet TE mode, you can use the MTS/T-BERD 4000 to emulate 
Ethernet terminal equipment by connecting to an Ethernet LAN or to the 
Ethernet port on the customer's modem. After connecting to the circuit, 
you can then use trace route, FTP, the web browser, or IP Ping to test for 
connectivity.

You can also ping through the modem to a network switch or web 
address to test for connectivity.

To select Ethernet TE mode

– From the Home screen, highlight Ethernet, and then press the 
RESULTS key.

The Ethernet tab appears, with the last viewed result menu (for 
example, the Ethernet Summary).

The Ethernet TE test involves the following steps:

– Specifying test settings

– Connecting to the line

– Performing tests

– Viewing results

Specifying test settings
Before you begin testing, make sure the test settings on the MTS/T-
BERD 4000 match the settings of the line that you are testing.

To specify test settings

1 From the Ethernet tab, press the SETUP key.

The last viewed setup page appears.

Configuring the settings can be done one of two ways:

– Press a number on the key pad that corresponds to the setting 
you want to configure.

– Use the arrow keys to highlight the setting you want to change, 
and then press the ENTER key. Press the CANCEL key to exit a 
menu. 

2 Press the General Ethernet soft key, and then specify the Media 
Type.
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This is the type of circuit (media) you are testing: 10M half or full 
duplex, 100M half or full duplex, or 1000M half or full duplex.

3 Press the SETUP key to move to the Network Settings.

4 Press the General Network soft key, and then specify the settings. 

The following table describes the settings. 

5 Press the LAN soft key, and then specify the settings. 

The following table describes the settings. 

CAUTION: FAULTY RESULTS

Any time the Network settings are changed, the network layer resets. 
If you change these settings during a test, you may cause errors in 
the test. Only change them before you begin a test. 

Setting Description

Emulation Type This specifies the data emulation: whether 
to Terminate the line to analyze the data or 
pass the data Through after analyzing it. 

Network Type Select the network type. 

IPoE is IP over Ethernet 

PPPoE is PPP over Ethernet

Auto Enable Specify whether to automatically enable the 
network layer. If set to Off, you must manu-
ally enable the network by pressing the 
Enable Network or PPP Logon soft key.

STUN Enabled 
(IPoE network 
only)

Select Yes or No. STUN allows calls across 
a NAT router. Change this only if you know 
it is necessary.

Setting Description

IP Mode
(IPoE networks)

Select either Static or DHCP (dynamic host 
configuration protocol).

IP Address
(Static IP mode)

Enter the LAN IP address.

Net Mask
(Static IP mode)

 Enter the net mask address.
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6 Press the PPP soft key, and then specify the settings. The following 
table describes the settings. 

Gateway
(Static IP mode)

Enter the gateway address.

DNS
(Static IP mode)

Enter the address of the DNS server.

Use Vendor ID
(DHCP mode)

Specify whether the vendor ID is used.

Use Vendor ID
(If Use Vendor 
ID
 is Yes)

Enter the vendor ID.

MAC Setting Specify whether the MAC is the factory 
default or user defined.

VLAN Specify whether VLANs are used.

VLAN ID If VLAN is On, specify the VLAN ID.

VLAN Priority If VLAN is On, specify the VLAN Priority.

Setting Description

PPP Mode Select Client or Server.

Client is normally used. Use Server only 
when you have a CO unit. This allows a 
remote modem to establish a PPP session 
with the MTS/T-BERD 4000.

NOTE: If you selected “Server” as the PPP 
mode, connect only to other devices with the 
same service name.

User Name Enter a valid user name.

This must be a valid user account with an 
ISP.

Setting Description
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7 Press the STUN soft key, and then specify the settings. 

STUN (Simple Transversal of UDP [User Datagram Protocol] 
Through NATs [Network Address Translators]) allows calls across a 
NAT router. These settings should only be changed if necessary.

The STUN settings are only available if the following settings are 
specified on the General Network Settings menu: Emulation Type is 
Terminate, Network Type is IPoE, and STUN Enabled is “Yes”. 

The following table describes the settings.

Use Provider Select Yes or No.

This option indicates whether to append the 
user name with the service provider domain 
name (for example, earthlink.net). Select 
Yes only if user names for the ISP must 
include the domain name as part of the user 
name. This setting automatically appends 
the @ sign for you.

Provider Enter the provider name.

This is required if you selected Yes for “Use 
Provider.”

Password Enter the user password.

This must be a valid password that matches 
the user name above. Passwords are often 
case-sensitive.

Use Service Select Yes or No to whether to use the Ser-
vice Name

Service Name Enter the Service Name. This is required if 
you selected Yes for “Use Service.”

Setting Description

Address Type Specify whether an IP Address or DNS 
Name is used.

Server IP Address
(IP Address Type)

Enter the IP address of the STUN server.

Setting Description
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You are finished specifying test settings.

Connecting to the line
After specifying the test settings, you can connect to the line.

To connect to the line

1 Connect one end of an Ethernet cable to the Ethernet jack on the 
top of the unit.

2 Connect the other end of the cable to an Ethernet jack. If connecting 
to a PC, use a cross-over cable.

Running a cable test
Before testing 10/100/1000 electrical Ethernet, IP, or TCP/UDP, you can 
use the MTS/T-BERD 4000 to examine the state of the cables used to 
transmit 10/100/1000 electrical signals. Typically this involves out-of-
service testing to determine the link status, the pair assignments for 

Server DNS Name 
(DNS Name Type)

Enter DNS name of the STUN server.

Server Port Enter the port number for the STUN 
server

Client Port Enter the client port number.

NAT Refresh Specify the NAT refresh rate. This is the 
number of seconds between messages 
to the STUN server to keep the NAT 
mapping alive.

Setting Description

NOTE:

If STUN is enabled, the network layer will not come up until the STUN 
client on the MTS/T-BERD 4000 has determined the type of NAT used 
between the MTS/T-BERD 4000 and the STUN server.
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1000M links, the polarity for each pair, and the pair skew. If the link is 
inactive, you can use the MTS/T-BERD 4000 to determine the nature of 
the fault.

To run a cable test

1 Connect to the line (see “Connecting to the line” on page 136).

2 Press the View soft key and then select Cable Test.

The Ethernet Cable Test screen appears.

3 Optional. To change the measurement units, use the Units soft key 
and select Feet or Meters.

4 Press the Start Test soft key.

The test runs and then displays the results.

See  “Ethernet TE results” on page 137 to learn what your results mean.

Viewing results
After specifying test settings and connecting to the line, you can view 
results.

To view results

1 Use the RESULTS key to access the Ethernet tab and view results.

The last viewed result screen appears.

2 To view another result category, do one of the following:

a Press the right or left arrow to cycle through the menus.

b Press the View soft key, and then select a category.

Ethernet TE results
The following result categories are available in the Ethernet TE applica-
tion:

– Ethernet Summary

NOTE:

The Ethernet Cable Test is an optional feature. If your unit is not 
equipped with this option, the Cable Test selection will not be avail-
able.
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– Ethernet Cable Test

– Event Log

You can view many additional results by pressing the arrow keys or use 
the View soft key and then select another category.

The following sections describe the results in each category.

Ethernet
Summary

results

This default results screen provides a summary of the most frequently 
used test results. Table 5 describes the Ethernet summary results.

Fig. 90 Summary page

Table 5 Ethernet summary results

Result Definition

Circuit diagram Located in the top area of the screen, shows 
a graphic indication of the circuit, including 
the link status (“Link Up/Link Down”).

Link status Located on the left of the screen, indicates 
whether the link is up or down.

Duplex Indicates the media type: half duplex or full 
duplex.

Speed Indicates the media speed: 10Mbps, 
100Mbps, or 1000Mbps.

Bytes Total bytes received and transmitted.
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Ethernet Cable
Test

This category provides statistics on the pairs inside the cable. Table 6 
describes the Ethernet Cable Test results.

Frames Total frames received and transmitted.

Errors Total errors received and transmitted.

Dropped Frames Total dropped frames

TX collisions Ethernet frames are transmitted “space-
available” when there is a break on the signal 
on the cable; sometimes frames are trans-
mitted at the same time as another transmit-
ter, causing a “collision” of frames.

Table 5 Ethernet summary results

Result Definition

Fig. 91 Cable Test Page

Table 6 Ethernet Cable Test results

Result Definition

Pair The pair being tested.

Channel Either Tx or Rx for 10/1000

A, B, C, or D for GigE
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Ethernet Event
Log

This category provides a running log of significant events and errors.

Fault Type Good appears if no faults are found, if a fault is 
detected, one of the following will appear: Open, 
Short, or Imp. Mismatch (Impedance)

Dx to fault The distance to the fault.

Polarity Normal or reversed. (Used for GigE tests.)

Skew 0, 16, 32, or 64 nanoseconds. (Used for GigE 
tests.)

Carrier When lit, indicates the link is active.

Speed Indicates the speed of the circuit: 10 Mbps, 
100 Mbps, or 1000 Mbps.

Auto Cross-
over

Indicates whether Auto Crossover is active.

Estimated 
Pair Length

Indicates the estimated length of each pair. This 
only populates when testing a GigE link.

NOTE:  This is a rough estimate.

Table 6 Ethernet Cable Test results (Continued)

Result Definition

Fig. 92 Event Log page
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Web browser

About the wbe
browser

With the web browser feature, you can provide visual proof to customers 
that a circuit is correctly provisioned all the way to the Internet. The 
browser works over Ethernet, and 802.11 interfaces, allowing you to surf 
the web from the customer's NID or demarcation point using only the 
MTS/T-BERD 4000. The browser allows you to connect to any public 
web site on the Internet through an internet service provider. 

Because the browser’s primary purpose is to demonstrate connectivity, it 
does not have all the capabilities of typical web browsers such as Internet 
Explorer or Netscape Navigator. The MTS/T-BERD 4000’s web browser 
has the following limitations:

– The browser does not cache web pages. The MTS/T-BERD 4000 
does not have sufficient memory to cache web pages. Each time a 
page is selected, the MTS/T-BERD 4000 re-loads the page. 

– The browser does not currently support Java applets, and will not 
display web pages written in Java. Sites optimized for quick down-
loads, such as DSLReports.com, are not supported because they 
are based on Java.

– The browser does not support Shockwave Flash (SWF) content.

The following sections in this chapter describe how to access and use the 
web browser.

Accessing the
web browser

Like IP ping, you must have an established underlying network connec-
tion, such as PPP over Ethernet, before you can use the browser. After 
you have a successful network connection, the MTS/T-BERD 4000’s 
Network status (on the top of the screen) turns green. If the Network 
status is red, the underlying connection is not ready, and the web 
browser (and IP ping) will not work.

To access the web browser

1 Make sure that you have a network connection, such as PPP over 
Ethernet.

2 Press the View soft key, and then select Browser.

3 Press the RESULTS key to move to the Browser tab.

4 Select Web Browser.
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The Web Browser Help screen appears.

Navigating the
browser

You can connect a USB mouse or a USB keyboard/mouse combination 
to the MTS/T-BERD 4000 to navigate the web browser as you would 
with a desktop computer. If you don’t use a mouse, you can use the 
MTS/T-BERD 4000 arrow keys. The following sections describe how to 
navigate the web browser.

Scrolling the view The screen displays only the top left area of a web page. To view other 
areas of a web page, use the MTS/T-BERD 4000 arrow keys to scroll the 
page view. If you have a touch screen, press the scroll bar to move the 
view.

Moving the pointer Using the shift key plus the arrow keys you can move the pointer to 
different areas of the web page. 

When the mouse pointer passes over a link, it changes to a pointing 
finger. 

Selecting links The following procedure describes how to select a link on a web page.

To select a link

1 Navigate to the link using the arrow keys and the shift+arrow keys.

When the pointer passes over the link, it changes to a pointing 
finger.

2 Press the ENTER key.

If you have a touch screen, double click the link.
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The screen changes as appropriate.

Moving among
fields

This feature is only available on units with a traditional screen (not a 
touch screen). After loading a page, use the Next Item to move to the 
next field on a page. This is the same function as pressing the tab key on 
a PC. Similarly, use the Prev Item to go backward one field (like shift-tab 
on the PC).

Entering data in
fields

The procedure for entering data is different depending on the type of 
screen you have.

To enter data in fields

If you have a touch screen, do the following:

1 Select the field, and then press the Show Keyboard soft key.

2 Use the on-screen keyboard to enter the data.

If you have a traditional screen, do the following:

1 Navigate to the field and then press the Edit Field soft key.

2 Use the alpha-numeric keypad on the MTS/T-BERD 4000 to enter 
the data into the dialog box. 

Returning to the
Home page

If at any time you wish to return to the Home page, press Navigate and 
then select Home.

Setting your home
page

To select a page as your home page, press the Options soft key and 
then Set as Home Page.

Going back one
page

If you want to go back to the previous page, press the Back soft key.

Opening a web
page

There are three ways to open a web page.

– Enter the address

– Select an address from the last five previously visited pages.

– Use a bookmark. See “Adding and deleting bookmarks” on 
page 145 for more information.
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Typing in an
address

The following procedure describes how to type in an address.

To type in an address

1 Press the Navigate soft key.

2 Select Enter URL.

3 Enter the URL.

To enter a dot (.), use the Symbols soft key.

4 Press the ENTER key.

Selecting a
previous address

The following procedure describes how to select a previously visited 
address.

To select a previous address

1 Press the Navigate soft key.

2 Select Recently Entered URLs.

The last five visited sites are listed.

3 Select the address you want to go to.

Selecting a
bookmark

To select a bookmarked site

1 Press the Bookmarks soft key.

A list of bookmarks appears.

2 Press the appropriate key to select the desired bookmark.

Stopping or
reloading a

page

After selecting a URL or bookmark, you can stop loading the page with 
the Stop soft key. This soft key only appears when the page is loading. 
If you have a touch screen, after the page fully loads, the soft key 
changes to Reload; on a traditional screen, it returns to Prev Item.

To reload the current page, press the Reload soft key.

Viewing the full
screen

To view more of the web page, press the Options soft key and then 
select Full Screen. The soft keys disappear. Select CANCEL full 
screen to end full screen mode.
144 User Manual 770000002/04



Chapter 9 Ethernet TE Testing
Web browser
Adding and
deleting

bookmarks

If there is a specific page that you would like to view or if you visit a site 
frequently, you can bookmark it. The following procedure describes how 
to add and delete bookmarks.

To add or delete bookmarks

1 When on a web page, press the Bookmarks soft key.

2 Do one of the following:

The address is added or removed from the bookmark list.

Exiting the
browser

When you are finished demonstrating internet access to the user, you 
should exit the browser.

To exit the browser

1 Press the RESULTS key to view a different tab.

This leaves the Browser running in the background.

2 To exit, select the View soft key and un-select Browser.

To... Do the following

Add the current URL to 
the list of saved book-
marks

Select Bookmark this Page.

The address will show up in the 
bookmark list the next time it is 
viewed.

 To delete a bookmark Select Manage Bookmarks, 
and then select Delete. A list of 
saved bookmarks appears.

Select the bookmark to delete.
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10

The scope function is a hot-plug feature enabled directly when inserting 
a USB scope supplied as an accessory (see"Reference of Scope" on 
page 197 ).

The topics discussed in this chapter are as follows:

– "Scope feature" on page 148

– "Scope connection" on page 148

– "Result display" on page 149

– "File toolbar" on page 151

– "Mosaic Mode" on page 153

– "New features available with the P5000 Scope" on page 154
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Scope feature
Scope feature
This feature enables you to verify that your optical connectors are in 
perfect shape and very clean condition.

Scope connection
To use the scope function, use a USB scope supplied by JDSU (see the 
list of all 4000 Platform accessories in “Reference of Scope” on 
page 197). 

1 Plug in your scope into a USB port from the 4000 Platform.

2 Connect probe with the fiber being inspected.

3 Push the button HOME, then use the arrows keys <- or -> to select 
the icon Scope and validate the selection by pushing the ENTER 
key.

Fig. 93 4000 Platform and scope

Fig. 94 Activation of Scope icon
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Result display
You may select this option while other options are already selected (e.g. 
OTDR)

Result display
To display the result, click on RESULTS while Scope is still actively 
selected.

Camera mode Set the key Camera/Freeze on Camera, to get a live picture of the scope 
result.

Luminosity and contrast settings

Luminosity and contrast may be set manually by using the 
key Bright/Cont.. Once you select which parameter you 
wish to modify, use the arrow keys  and  to tune the 
luminosity or contrast to the desired value. Note that the 
set values are displayed on the key.

You may also choose to use the function Auto Contrast in 
order to get settings calculated automatically by the instru-
ment.

In order to see the Scope icon and select it, you must first make sure 
that the scope is correctly plugged into an available USB slot, before 
you reach this screen. If this was not done, quit this screen and come 
back to it after plugging in your scope correctly. This will refresh your 
detected devices.

Use the focus control to adjust the focus of the image

NOTE

Saturated parts of the picture appear in yellow. Modify the luminosity 
and contrast settings or use Auto contrast to modify the actual set-
ting and remove saturation.

Auto Contrast must be used with a pristine (perfectly clean, 
undamaged) fiber connector. Changing the brightness or 
contrast settings can significantly change the fiber inspection 
test result.
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Freeze mode Once the image is acceptable (sharpness, luminosity and contrast are 
tuned correctly), you may freeze the picture. This feature allows to store 
in memory the resulting picture in order later to compare it to others or 
save it in a file.

Adding a comment

A key Comment allows you to enter a comment to your picture if neces-
sary. This comment appears at the bottom left of the picture. 

The right bottom of the frozen picture also contains the date of the acqui-
sition (where the picture was frozen).

Fig. 95 Example of a fiber connector endface image when 
using the scope option

Freezing a scope result does not store the picture in a file (see "Sav-
ing a picture" on page 151). The result will be lost if the instrument is 
shut off, or if more than 3 pictures are frozen (see "Mosaic Mode" on 
page 153).

NOTE

The button set on the lead, or the QuickCapture™ on the P5000 
allows to freeze the picture or to take a snapshot.

NOTE

Both the comment and the date will be saved with the picture if that 
picture is saved later on.
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File toolbar
Click on the FILE button to access the File toolbar on the right of the 
screen.

Saving a
picture

It is possible to save the frozen picture resulting from the scope.

To do this, select Save. An edition screen is displayed in which to enter 
alphanumerical characters in order to save the file with an appropriate 
name. 

NOTE

The comment may be modified at any time later on.

Fig. 96 Frozen Scope image

Com- Date of acquisi-

NOTE

By default, files are saved and read in the directorydisk/Scope. It is 
possible to move these files to another place, via the file explorer.

However, reading will always be done in the initial directory.

NOTE

Files are saved using the JPG format.
User Manual 770000002/04 151



Chapter 10 Scope
File toolbar
Loading a
picture

It is possible to retrieve and load a picture stored in the default directory 
(see "Frozen Scope image" on page 151 to know the default directory).

1 Select Load. The list of all files in a JPEG format are presented in a 
list, showing for each file :

– An icon indicating the type of JPG file (  unknown picture or  
Recognized scope picture)

– The name of the file

– The date of acquisition of the picture (only appears for recognized 
scope pictures)

– A potential comment (only appears for recognized scope pictures if 
comment is present)

2 Click on Load/Confirm Load to load the image selected

Recognized pictures are images resulting from the Scope option and 
saved on disk via the 4000 Platform.

Even though the JPG editor of the Scope function has been designed to 
display Scope pictures in black & white, it is also possible to open any 
JPG valid file and display in color the corresponding picture. That picture 
is enlarged or shrunk to the size of the display (full screen or mosaic, 
see."Mosaic Mode" on page 153).

Click on the RESULTS button if you wish to come back to the previous 
screen

Fig. 97 List of JPG files that can be loaded

Some pictures resulting from the Scope option may appear neverthe-
less unrecognized, if they have been stored with a different Scope 
application, or if the JPG file has been opened and modified under 
another JPG editor. Opening such a picture and saving it again with 
the current 4000 Platform software version will allow this file to be dis-
played later with the scope logo.

NOTE

The JPG editor may open all files in a JPG valid format, wether the 
extension is «.jpg» or «.jpeg».
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Mosaic Mode
Mosaic Mode
It is possible to display only one picture in full screen (640 * 390 pixels) 
or up to four pictures (320*180 pixels each, including the live camera 
picture) in mosaic mode. Use the key Full scr./Mosaic to switch from 
one mode to another.

You may select of the pictures by using the arrow keys , , . or .

The selected picture is framed in green.

The toolbar on the right varies according to which picture is selected 
(camera, or static picture).

Camera

All the Contrast and Luminosity settings are available just like in full 
screen. 

Snapshot The live picture from the camera is frozen but does not
replace the live picture at position 1. The new snapshot
is placed at the second position, and all existing pictures
are pushed to the next position. 

Fig. 98 Mosaic mode

Position 1 :

LIVE CAMERA

Position 2:
Snapshot saved on disk : connector cleaned

Position 3 : 
Connector 
before being 
cleaned

Position 4 : Regular JPEG image

Selected 
picture

If all positions were taken, the picture that was once at the fourth posi-
tion is unloaded from memory. Frozen pictures and snapshots are 
lost, unless they were saved on the internal memory.
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Static pictures

Comment It is possible to add a comment to a picture, just like in
full screen.

File toolbar The File toolbar is also available in mosaic mode. Actions made by this 
toolbar will concern the selected file.

Click on the FILE button to access the File toolbar on the right of the 
screen.

Up to two choices are presented :

Load Refer to "Loading a picture" on page 152

Save This choice is only available if the picture has been
recognised by the system as a Scope picture, either
before opening it or after opening it (pictures created
with different versions). When this choice is available,
refer to "Saving a picture" on page 151. 

A new loaded picture will take the place of the selected picture, unless:

– the selected picture corresponds to the camera (first position). In 
this case, the rule is the same as when a snapshot is made (see 
"Camera" on page 153).

– free spots are available in the mosaic. In this case, the new picture 
takes the second position while other ones are pushed to the next 
position.

New features available with the P5000 Scope
The  P5000 Digital Probe Microscope is a portable handheld microscope 
used to view and inspect both the bulkhead (female) and patch cord 
(male) sides of fiber connectors as well as other optical devices, such as 
transceivers. 

The probe is specially designed to fit and operate comfortably and easily 
in-hand, allowing the user to inspect hard-to-reach connectors that are 
installed on the back side of patch panels or inside hardware devices. 
The P5000 requires an FBPT inspection tip and is connected to the 4000 
Base Unit with a USB 2.0 connector.

NOTE

Clicking on Save while the camera is selected will both create a snap-
shot (see "Camera" on page 153) and save it on disk.
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New features available with the P5000 Scope
The P5000 Digital Scope Kit sold with the 4000 Base Unit (Ref 
EDFSCOPESK) contains the standard barrel assembly (FBPP-BAP1), 
standard patch cord tips and standard bulkhead tips.

Configuring the
P5000 Scope

Once the Fiber Microscope icon is selected on the Home page , 
press Setup key to configure the P5000.

The following screen displays:

Warning on tips use

The Pass/Fail analysis function on the MTS / T-BERD 4000 can only be 
used with certain inspection tips mounted on the P5000.

Only tips that attach to the standard barrel assembly (ref: FBPP- BAP1) 
will give an accurate Pass/Fail result: standard patch cord tips and stan-
dard bulkhead type.

Fig. 99 P5000 Probe components

QuickcaptureTM button
Instantly captures the image

Focus Control

Latch lock
Squeeze both ends to release

Barrel assembly USB 2.0 
connector

6 FT COIL Cable

Inspection tip

Before using the P5000 scope, make sure the Bluetooth option 
has not been activated, even once, after the start of the MTS/ T-
BERD 4000. If it has been activated, stop and restart the 
equipment before using the P5000 Scope.

Fig. 100 Scope Setup
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Specially tips, such as LC Bulkhead Long Reach (ref:FBPT - LC - L) and 
MTP Bulkhead x-axis pan knob (ref:FBPT - MTP) can be used only to 
view and record the fiber end-face, but will cause the MTS-4000 to give 
a false Test result.

Test On the line Profile, select the Profile which will be used for the test of 
fiber connector:

– IEC SM-UPC: Pass/Fail criteria for single-mode UPC connectors 
from IEC 61300-3-35 standard.

– IEC SM-APC: Pass/Fail criteria for single-mode APC connectors 
from IEC 61300-3-35 standard.

Profiles contain the analysis parameters by which PASS/FAIL criteria are 
determined.

Once the line is selected, you can also add a new profile, clicking on the 
Add Button (see "Adding a new profile" on page 157).

On the line P5000 Type, select FBP-P5000.

Fig. 101 Use of tips

Barrel assembly

MTP-APC Patch Cord 
Tips / Flare adapter

60° Angled 
Bulkhead tips

RibbonDriveTM 
Tips

View and record fiber end-face (false test results)

Standard
patch cord tips

Standard
Bulkhead tips

Long Reach Bulkhead tips

Standard
patch cord tips

Standard
bulkhead tips Barrel assembly

Pass / Fail results
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Report The parameters in Report box allow to configure the Report page setup.

On the line Company, enter the name of your company using the edition 
keypad which will displayed automatically once clicking in the edition 
field or on the right arrow key.

On the line Logo, you can select an image on the 4000 Explorer once 
clicking on the right arrow key, which will be displayed on the upper left 
part of the report. Press the SETUP key to return back to the Setup page.

On the line Operator, you can enter the name of the operator, which will 
be displayed on the header of the report.

See Figure 105 on page 161 for a description of the pdf report.

Fiber The Fiber box allows to configure the fiber plugged to the scope.

On the line Fiber Name, use the edition keypad, which will display by 
clicking on the right arrow key, to enter a specific name for the fiber.

On the line Fiber Number, use the numeric keypad, which will display by 
clicking on the right arrow key, to enter the fiber number.

Press Exit to return to the Results screen of the scope.

Adding a new
profile

Once the Setup screen of the scope is displayed, you can add a specific 
profile which will be used for the test.

1 Check first the profile has been created via FiberChek2TM, and the 
file is stored on one storage media of the MTS 4000 (disk, internal or 
USB memory stick). If using a memory stick, select USB FLASH.

2 On the Setup screen, select Profile parameter and press Add key.

3 On the explorer, select the file which will be used as profile (icon 
 ; extension: .PRO)

4 Press Load

Once loaded, the display goes back automatically to Setup screen.

5 Use arrow keys to select the profile just loaded.

Removing a profile

1 In the Profile list, select the profile to be deleted, using the arrow 
keys.

2 Press Remove key.

3 Press Exit.
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Launching a
test of the

connector and
fiber end-face

Once the connector is plugged to the microscope, the following screen 
displays:

See"Camera mode" on page 149 and  "Freeze mode" on page 150 for 
more information on commands available.

To launch the test:

1 Check first the display, and modify if necessary the Brightness and 
Contrast using keys  and .

2 Press Test key to launch the test of plugged fiber connector.

The test is completed:

– once the Led Testing is no more lit in red

– once the icon   is no more displayed on the upper banner

– once a screen as the following one displays:

Fig. 102 Example of the result using the P5000 scope

NOTE

Manually changing the brightness or contrast settings can significantly 
change the fiber inspection test results.
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A summary of test results is displayed on the right, upper part of the 
screen.

– Zone A: represents the Core zone: it is the area 
surrounding the core

– Zone B: represents the Cladding zone. It 
surrounds the majority of the fiber cladding.

– Zone C: represents the Ferrule zone: it identifies 
a portion of the ferrule near and around the fiber

Fig. 103 Test results

Test result in High mag.

Zone C

Zone B

Zone A

NOTE

To return to a Live Camera image, press the Camera/Freeze key or 
press the Full Screen/Mosaic key to view both the live image and a 
test result simultaneously.

In Mosaic mode, the result of the test only displays Pass or Fail infor-
mation; the status of each zone is displayed in full screen mode.

Fig. 104 Test result in mosaic mode
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Saving the test
result in a jpg

file

Once the test has been performed, and the result is displayed on the 
MTS / T-BERD 4000 screen:

1 Click on Save key to save a jpg file of the test result on the disk of 
the MTS / T-BERD 4000, in the directory Scope.

2 On the edition keypad, enter the name of the jpg file

3 Press Enter to validate and save the document.

The file is automatically saved on the disk, in the directory Scope.

Generating a
report

Once a test has been performed via the P5000 Microscope, a report can 
be generated in a pdf document.

Generating the report

1 In mosaïc mode, check the correct test result is selected (framed in 
green)..

2 Press the FILE button

The menu bar changes

3 Press the Report key

4 On the edition keypad, enter the name of the pdf file and press 
ENTER to validate and start the report generation.

The report generation is completed once the icon  is no more 
displayed on the upper banner.

Display of the report

Once the report has been generated:

1 Return to the HOME page.

2 Select Apps > File Explorer

3 In the Explorer page, select the directory Scope.

4 Select the pdf file of the report.

5 Press Load > Confirm Load

The pdf report displays in the PDF Reader onto the MTS / T-BERD 
4000.

NOTE

The pdf report will be saved on the disk, in the directory Scope.
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Fig. 105 PDF report

Logo, company & opera-
tor name selected in the 
Setup page (see “Report” 
on page 157)
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Chapter 11 File management
11

The files management with the 4000 Platform can be performed, wether 
a module is set onto the Base or not.

The topics discussed in this chapter are as follows:

– “File menu” on page 164

– “Directory edit function” on page 167

– “File editing function” on page 169

CAUTION

The following chapter discuss about the management of files, other 
than FO ones, using the FILE button or the File Explorer Application, 
when no module is set into the Platfomr or when the FO Module is not 
selected on the System page (see the 4100 Module Series User 
Manual for the file reading and trace display...).
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File menu
– Press the FILE button.

or

– On the Home page, select App’s > File Explorer applcation.

The File menu appears.

Description of
the explorer

The explorer is used to select the storage medium, and to create or 
rename directories and files:

– The left-hand part presents the storage architecture. Use the 
keys  and  to move around among all the media and their 
respective directories. 

– The right-hand part displays all the files present in the directory 
selected.

The direction keys can be used to move horizontally between the two 
parts and vertically within each zone.

Storage media For saving or recalling data, the 4000 Platform offers a wide choice of 
media, both built-in and external.

Free space on selected media is clearly displayed at the bottom of the 
left panel.

Fig. 106 File Menu

Free space for the 
media selected
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Storage media
built into the 4000

Platform

– An internal memory 

– An extended internal memory, on option

External USB
storage media

The Base Unit is equipped with 2 USB ports as standard. One of these 
can be used to connect an external storage medium, in particular a USB 
memory stick.

USB memory stick connection

Insert the USB memory stick in one of the 4000 Base Unit's USB port. 

A sound is emitted to confirm the successful insertion and recogni-
tion of a USB memory stick.

Then, the icon  is displayed in the upper banner to inform the 
user the USB stick is ready to be used.

Do not connect a USB memory stick while a USB printer is printing.

If the Base Unit does not emit a beep, disconnect and reconnect the USB 
memory stick (do not perform this action too quickly - wait 5 seconds 
between the disconnection and reconnection).

If after several trials, no beep is emitted and no icon is visible, two prob-
lems can be considered:

– A previous USB memory stick has not been properly disconnected. 
Go to “USB memory stick disconnection” on page 166

– the USB memory stick is not detected by the Base Unit: use another 
USB memory stick or another storage medium or transfer data via 
Ethernet (see “Accessing the internal memory or the USB memory 
stick of the 4000 Platform via a PC” on page 38).

In case of errors, the icon  is displayed:

– The stick is not formatted

– The stick has been removed without prior Eject USB key use and 
some applications are still using it.

If the size of the free space is not correct, the USB memory stick must be 
formatted.

NOTE

Although two USB ports are present, it is not possible to use simulta-
neously more than one external USB storage medium. 

For the high capacity USB sticks of 2Go or higher, only the memory 
sticks provided by JDSU are recommended.
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a Press the SYSTEM button

b Successively select Expert Tools>Media Utilities>Usbflash 
Format

c Confirm your choice to format the USB memory stick

d Once formatted, disconnect the USB memory stick using the 
Eject USB key and reconnect it.

USB memory stick disconnection

Before disconnecting the USB memory stick, always select a storage 
device different from usbflash (select disk for example) in the explorer. 

Make sure you no longer have any running applications using the 
usbflash storage media.

The user must push the EJECT USB key, which is available in File > 
Explorer or Link Manager, but also in Expert Tools > Media Utilities.

The icon becomes  to indicate it can be removed safely. In this state, 
the USB stick cannot be used anymore

The USB memory stick can then be disconnected from the Base Unit's 
USB port.

As for any media formatting, please note that all data present on 
the USB memory stick will be irremediably lost.

When a file is moved in the explorer of the Base Unit, the end of 
the move on the screen does not mean that writing of data into 
the memory is complete. Some data may still be in a writing 
process if the storage unit is removed prematurely. 

NOTE

If the Base Unit operates on battery and is switched off before the 
USB memory stick is properly disconnected, all the applications using 
the usbflash storage media will be automatically turned off and the 
USB memory stick can be disconnected afterwards without any prob-
lem.

NOTE

If the 4000 is on mains and is switched off before the USB memory 
stick is properly disconnected, the Base Unit needs to be completely 
switched off (using the ON/OFF button and main plug unplugged).
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Abbreviations for
storage media

The abbreviations used in the explorer for the different storage media 
are:

Directory edit function
The editing functions are similar to those of other explorers. The directo-
ries are at the top left of the screen. If the cursor is in this part, the func-
tions proposed by the keys are specific to the management of the 
directories.

Selection of
directories

If the cursor is in the left-hand part of the screen:

– the direction keys can be used to select a directory. 

– the ENTER key opens the directory selected and closes it when 
pressed a second time.

NOTE

The USB memory stick can also be removed using the Expert Tools 
> Media Utilities menu (see “Removing the USB memory stick” on 
page 62).

Abbreviation Storage medium

disk Internal flash memory

extmem Internal extended memory (option)

usbflash USB memory stick

bluetooth-inbox Bluetooth storage media (option)1

1. The files stored in bluetooth-inbox are lost when the Platform is 
switched off.

Do not confuse "Selected" with "Active". A directory may be displayed 
in video inverse, to show that it is the current working directory. If it 
does not have a broken red line round it, it is not active.
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Edition of
directories

When a directory is selected, the keys offer different functions available 
onto the directories.

Create Directory This key allos the creation of a new directory.

– Select the storage media on which the directory will be stored the 
new directory

– Click on Create Directory

The editor enables entry of its name.

– Enter a name for the directory

– Click on Enter

The directory is saved in the storage media previously selected.

Rename Directory This function allows to rename the directory selected.

– Select the directory which name must be modified.

Fig. 107 Selected / Active File

Active: working directory Selected: the cursor is here

Broken red line around

Fig. 108 Operations available on the directories

Operations
 on the

directories
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– Click on Rename Directory

The editor is displayed

– Enter a new nam for the directory

– Click on Enter

The directory is saved under a new name, on the same storage 
media. 

Edit This key opens a new menu providing functions for editing the directo-
ries.

Copying a directory on the same media or on another media

– Select the directory to be copied

– Click on Copy or Cut

– Select the directory and / or the storage media in which the directory 
will be placed.

– Click on Paste

Remove a
directory

The Edit menu allows to delete a directory from the storage media.

– Select the directory to be deleted.

– Click on Delete

A confirmation message is displayed: click on Yes to confirm the 
directory removal or on No to cancel the operation.

File editing function
Once the file(s) is / are selected, several operations are available with the 
4000 Platform.

The right-hand part of the screen can be used to work on the files in the 
directory selected.

NOTE

A whole directory with its contents can be copied into another direc-
tory or on to another storage medium.
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File Format and
Type

A table gives the list of the files in the directory, showing for each one: its 
name, size, type and date of creation.

File Types For files recognized by the 4000 Platform, the types are symbolized by 
icons. E.g.

Fig. 109 Available operations on files

Operations
 on
files

Icon Type of FO file

OTDR file (.SOR extension)

Multi OTDR file (.MSOR extension)

OSA file (.OSA extension)

Power Meter file (.LTS extension)

Icon Type of file

HTML file (.HTML extension)

PDF File (.PDF extension)

Text file (.TXT extension)

License file (.LIC extension)
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Format of files – OTDR files that can be read by the 4000 Platform are type Bellcore 
1.0, 1.1 and 2.0.

– The PDF files are opened via the PDF viewer (see "PDF viewer" on 
page 78).

– The HTML, audio/video, JPEG and XML files are openend via the 
Web Browser (see “Web browser” on page 80).

– The LIC files allow to load new licenses (see “Install Option” on 
page 59).

– The TXT and CSV files are opened via the Text Editor application 
(see "Text Editor" on page 85)

To read other formats, use JDSU’s FiberTrace or FiberCable software.

Easy file
selection

To select one or several files:

– Click on  to pass from the directory to hte file selection

– Use the arrows  and  to move around the files list.

– Click on ENTER to validate the selection of each file wished.

To select all the files from the directory, click on Select All.

CSV file (.CSV extension)

JPEG / JPG file (.JPEG extension)

XML file (.XML extension)

Audio / Video file (.AVI, .MP3... extension)

With the 4000 Platform, you can open and load any kind of file 
(OTDR and LTS) even if the corresponding modules are not set 
into the Platform.
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To select a list of files using the keys of the Platform:

1 Select and validate the first file of the list (red display)

2 Set the cursor on the last file of the list (blue display)

3 Maintain the validation key  pushed until all the files from the list 
are selected

Fig. 110 Selection Directory - File

Fig. 111 Selection of a list of files

Directory selected Files selected

NOTE

If a mouse is used, click on a file to select it, and click again to dese-
lect it.

If no file has been selected by the ENTER key, the file where the cur-
sor is positioned is taken as selected.

On the other hand, if a file has been selected with the ENTER key, and 
the cursor is on another file, the latter is not selected!
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Rename File Opens the editor to modify the name of the file:

– Select the file in the list

– Click on Rename File.

The Editor is displayed.

– Enter a new name for the file.

– Click on Enter

Sorting the files Wether files are selected or not, the key Sort allows to access to a sub-
menu allowing to sort te file accorfing to pre-defined parameters:

– Sort by name: the files will be displayed in an ascending order 
(from A to Z). If you click once again on the key, the files will be 
displayed in a descending order (from Z to A).

– Sort by Size: by cliking once on this key, the files will be displayed 
from the smallest to the heaviest one. Clicking a second time allows 
to sort the files in opposite order.

– Sort by Type: clicking once on this key; the 4000 Platform will 
display the files in an ascending order (the file type A to file type W). 
By clicking again, the 4000 Platform will display the files in opposite 
order.

– Sort by Date: clicking once on this key; the 4000 Platform will 
display the files from the more recent to the less one. By clicking 
again on this key, the 4000 Platform will display the files from the 
older to the more recent one.

Copying one /
several file(s)

You can copy files from one storage media or from a directory to another.

– Select the file(s) to be copied

– Click on Copy or Cut

– Select the directory / the storage media in which the file(s) will be 
saved.

– Click on Paste

Merging txt/pdf
Files

When saving a measurement result, in addition to the trace file, a txt file 
can be saved for each measurement type:

– with OTDR traces, select "+ txt" in the line File Type on Menu 
screen (see 4100 Module Series User Manual).
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– with the LTS functions, the txt file is automatically generated 
when saving the results.

You can also choose to print the result trace in pdf:

1 In the Config System page, in the Printer menu, select Printer > 
File (formatted), and on the line Type, select PDF.

2 Return to the OTDR trace and press simultaneously the left and 
right arrow keys to start the PDF printing.

The key Merge is used to merge several tx/pdf t files from measurements 
into one txt/pdf file, putting together the results of all txt/pdf files.

– In the explorer, select the files generated with the trace files you 
want. 

– Click on Edit > Merge key

The file merged_files.txt/pdf is automatically saved in the same directory 
as the one where the files have been selected.

Merging pdf files

You can combine bidir IL / ORL and OTDR measurement results 
(acquired with FiberComplete function set onto an OTDR Module) into a 
single pdf:

1 Once both results are generated in pdf, select them in the Explorer 
page.

2 Press Edit > Merge keys

Once merging is completed, a new pdf file is created, which name by 
default is: «merged_year_month_day__hour_min_sec.pdf».

See User Manual 4100M02 for more information.

Sending files by
mail

This option appears if Mail has been defined with Ethernet, in the system 
setup menu (see “File Export” on page 53).

1 Select the file(s) to be sent.

2 Click on Send by mail

The editor is displayed.

NOTE

The file merged_files.txt can be renamed once it is saved.
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3 You will have to fill in the two following fields:

– Mail To: Using the key , display the edition window which allows 
you to enter the name of the recipient.

– Subject: in the same way, enter the subject of the mail or a 
comment if necessary. By default, the name of the mail is «Result 
+ sending date».

4 Click on Enter

Once the mail has been sent, the following message is displayed: Mail 
Sent. Hit any key to continue.

Sending files by
Bluetooth

Once the connection has been established with a bluetooth device (see 
“Setting up a Bluetooth connection” on page 116):

1 Go in the File Explorer.

2 Select the file(s) to be transferred from the Platform toward the 
device via bluetooth

Fig. 112 Enter e-mail address

Enter the e-mail 
address

NOTE

If at least one function is selected in the System page (yellow icon), 
this two parameters «Mail to» and «Subject» can be configured by 
default in the Explorer page > File Export (see “File Export” on 
page 53)

NOTE

You can also send a file by e-mail to a contact onto another Platform, 
by using the Mail application (see “eMail Application” on page 102).
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3 Push the Send by Bluetooth key

You can also transfer file(s) from the bluetooth device toward the Plat-
form.

In this case, the files received will be stored in a storage media created 
automatically on the Platform: bluetooth-inbox.

REMINDER:
To transfer files, the File Export selection on the System 
Settings>I/O Interfaces menu must be set to Bluetooth.

WARNING

The files stored in bluetooth-inbox will be lost when the 4000 Platform 
will be switched off. Move the files you wish to keep toward another 
storage media (disk, usb key, extmem...).
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12

This chapter gives the main maintenance procedure for the 4000 Plat-
form.

The topics discussed in this chapter are as follows:

– “Maintenance procedure” on page 178

– “Cleaning” on page 179

– “Precautions relating to optical connections” on page 179

– “Installing a new version of the software” on page 180

– “Replacement of the small PCB battery (for backup)” on page 186

– “Touchscreen calibration” on page 186

– “General information on warranty” on page 187

For software updates, or to find our JDSU representatives and 
technical support offices around the world, please visit our 
web site: www.jdsu.com.
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Maintenance procedure

Maintenance work on this instrument must only be undertaken 
by qualified personnel using suitable equipment.

In most cases, it is advisable to contact the nearest JDSU Service 
Centre, which will undertake the appropriate troubleshooting and repair 
work.
The performance and technical complexity of the 4000 Platform class 
this instrument in a new generation of equipment, for which JDSU has 
laid down a maintenance policy based on the principle of standard 
module replacement.
In implementation of this policy, we have set up powerful card trouble-
shooting test resources in our factories and a rapid dispatch system 
operating between our factories and branches.
Only by this procedure can the high quality of the instrument continue to 
be ensured after repair work. This procedure also has the advantage of 
reducing repair costs and time.

In the interests of quality and efficiency, we strongly recommend adop-
tion of the following procedure in the event of a fault, before any other 
steps are taken:

– Verify that the instrument is plugged in.

– Check the connections of any peripheral equipment to the 4000 
Platform.

– If a fault is detected, or in case of doubt, it is advisable to contact the 
nearest JDSU Service Centre, which will undertake the appropriate 
repair work. 

Returning an
instrument

When returning an instrument, it is essential to indicate the following 
minimum information:

– the type and serial number of the instrument (on the identification 
label) and the configuration code (under the bar code)

– a description of the fault found on the instrument.

The returned instrument will then be repaired and calibrated.

Guarantee
conditions

Any repair operation supervening within the guarantee period of the 
instrument will be carried out at the expense of JDSU. However, for any 
sub-assembly upon which work has been carried out otherwise than by 
JDSU Service Centers, the cost of a replacement sub-assembly will be 
invoiced.
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Cleaning plates
and housings

The front and rear plates and the housings may become tarnished with 
handling. To clean them, use only a rag moistened with soapy water.

Never use any product containing acetone, trichloro-ethylene, benzine or 
alcohol, as these will attack the printed markings.

Cleaning the
screen

To clean the screen, use an antistatic product.

Precautions relating to optical connections
– The normal operating life of an optical connector is usually of the 

order of a few hundred manipulations. It is therefore advisable to 
manipulate the optical connections of the 4000 Platform as rarely as 
possible.

– The proper operation of the instrument and its accuracy of measure-
ment are dependent on the cleanliness of the environment and the 
optical connectors as well as the care taken in its manipulation.

– The optical connectors must therefore be clean and dust-free. If the 
optical connection is not being used, protect the connections of 
4000 Platform using the protective plugs provided.

As an example, the results of measurements made with connectors that 
have not been cleaned will display an error of the order of 10% for all 
measurements. This error is additional to other errors inherent in the 
measurement process and due, for example, to the quality of the fiber 
(circularity and concentricity), the means of connection (axis alignment, 
distance between fiber faces, quality of fiber faces) and propagation 
modes.

Cleaning the
optical cable

connector

– Use a non-linting type of paper, such as Joseph paper, soaked in 
isopropylic alcohol.

– Pay particular attention to the polished face of the fiber, rubbing it in 
a direction perpendicular to the axis of the fiber.
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Cleaning the
optical

connections of
the 4000
Platform

– Squirt a highly volatile solvent (such as isopropylic alcohol) into the 
connector.

– Blow out the connector using a clean dry air supply from an aerosol 
can fitted with an extension.

Installing a new version of the software

Obtaining the
New software

The new version of the software can either be procured on a storage 
medium (USB stick memory) from your JDSU Customer Service, or can 
be downloaded from JDSU’s internet site: www.jdsu.com.

Downloading
from Internet

When the software is obtained from the Internet, it must be saved on a 
storage medium before the software upgrade of the product can be 
carried out. To do this:

1 Open Internet Explorer

2 Enter the address: http://www.jdsu.com

3 Open the page of the product concerned

– MTS 4000 Multiple Services Test Platform

or

– T-BERD 4000 Multiple Services Test Platform 

NOTE

If your module has a universal connector, unscrew its adaptor to 
access the ferule.

When a new software version is loaded, there is a risk of re-initializa-
tion of the internal memory. Before installing the new software, it is 
therefore advisable to save the results in the memory, using the Save 
function called up by the FILE button.

Do not interrupt the installation process, as this could damage the 
instrument.

To avoid any interruption of the installation procedure, the 4000 Plat-
form must be operating on the mains: if the procedure is started while 
operating on battery, a message indicates that the instrument must be 
connected to the mains.
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4 Click on the tab Downloads.

5 Click on the link 4000 Firmware Update

A new page opens,displaying the current version available and 
several links.

6 Click on the icon  or on the exe file to load the archive.

7 In the new dialog box displayed, click on Save to save the exe file 
on the PC.

8 Once completed, connect the USB memory stick to the PC and 
follow the instructions chapter “Installation from a USB memory 
stick” on page 183, from step 7.

Installation
from Ethernet

Before starting the software upgrade via Ethernet, make sure the IP 
adress of the PC server.

The update can be perfomred directly onto the equipment, using an http 
address.

1 Connect the 4000 4000 Base Unit to a PC via an Ethernet link.

2 On the Home page, press System Settings key

3 In I/O Interfaces, on the line Ethernet, select Mode: Dynamic.

Fig. 113 Internet page for MTS / T-BERD 4000 Update

click to download the 
new update
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4 In the Upgrade Server box::

– On the line Address Type, select Server name

– On the line Server Name, enter the address: 
4k.updatemyunit.net

5 In the I/O Interfaces box::

– On the line Use proxy, select No, Manual or Auto wether a 
proxy is used or not.

6 Once completed, press Exit to return to the Home page.

7 Press, in succession, Expert Tools > Upgrades > Software 
Upgrade > Upgrade via Ethernet.

The message Verify IP address of PC server appears. 

8 Click on Continue. 

The list of the software versions available on the PC is displayed 
next to the versions installed on the 4000 Platform.

9 Click on  Show Prev choice or  Show Next Choice to display the 
previous and next versions available.

10 Click on Confirm to start the upgrade of the selected software(s).
or
Click on Confirm All Choices to upgrade all versions.

Upgrading begins. The 4000 Platform is automatically rebooted. 
Upgrading takes several minutes. At the end, the 4000 Platform is 
automatically restarted.

Fig. 114 Configuration of the Upgrade Server

NOTE

This configuration is already available on delivery of the equipment.

NOTE

The software versions list does not always appear (cf previous ver-
sions) as well as the Show Previous / Next Choice buttons and the 
Confirm/Continue key. In this case, the upgrading starts automati-
cally.
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Installation
from a USB

memory stick

You must be equipped with a USB memory stick with a minimum capacity 
of 128 Mo.

Before installing the upgrade, you must format the USB memory stick 
(steps 1 to 5).

1 Insert the memory stick into one of the sockets on the 4000 Platform 
provided for this purpose.

2 Switch on the 4000 Platform

3 Press the HOME button

4 Successively select Expert tools >  Media utilities > Usbflash 
Format.

5 Confirm your choice to actually format the USB memory stick.

6 Once formated, disconnect the USB memory stick from the 4000 
Platform using the key Eject USB in the Media Utilities page.

7 Connect the USB memory stick to the PC

During the upgrade, the Testing indicator is lit in red. Do not 
push any button while the indicator is lit.

USB memory keys can be very different.

They differ on Hw and Sw aspects, even inside a given brand.

In particular, USB memory keys targeting audio recording are often 
formatted in very specific ways and the format is often very different 
from a standard FAT.

For all these reasons, we advise users to use memory Keys provided 
by JDSU.

In any case, USB memory keys which are recognized by the 4000 
Platform (a beep is generated when plugged on the 4000 Platform) 
but which cannot be read or written, should be formatted on the 
4000 Platform with the Usbflash Format utility, in Expert tools > 
Media utilities.

If a problem occurs with the USB key you are using, contact your 
Local Technical Assistance Center.

As for any media formatting, please note that all data present on the 
USB memory stick will be irremediably lost.
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8 Unzip the upgrade files on the PC and transfer it to the USB memory 
stick:

a Download and save on your PC the .exe upgrade file that you 
can get from the web ( http://www.jdsu.com, see “Downloading 
from Internet” on page 180).  

b Once the transfer is completed, double click on the .exe file: A 
window  will appear. Check that the folder is correct i.e. the USB 
memory stick driver is appearing in the line at the bottom of the 
dialog box then press OK. If not, click on the icon  in order to 
select the right USB drive.

c Press OK and wait for the end of loading.

9 Then remove the USB memory stick, using the appropriate proce-
dure, from your PC

10 Insert the memory stick into one of the USB ports on the Platform.

11 Press the HOME button, then successively the buttons Expert tools 
> Upgrades > Software Upgrade > Upgrade from USB.

The message Are you sure? is displayed

12 Click on Confirm. 

The list of the software versions available on the USB stick is 
displayed next to the versions installed on the 4000 Platform.

13 Click on Show Prev choice or Show Next Choice to display the 
previous and next versions available.

Fig. 115 List of software update

NOTE

A bip is emitted each time the USB memory stick is inserted or 
removed from the 4000 Platform.
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14 Click on Confirm this Choice to start the upgrade of the selected 
software(s). 
or
Click on Confirm All Choices to upgrade all versions.

Upgrading begins. The 4000 Platform is automatically rebooted. 
Upgrading takes several minutes.. Finally, the 4000 Platform is auto-
matically restarted.

Upgrading from
the boot

This method is used to make a complete reinstallation of the software 
versions.

1 Turn off the MTS/T-BERD 4000 using the ON/OFF button, keeping 
the equipment connected to the mains.

2 Insert the USB stick onto which the software versions are stored into 
one of the USB port of the Platform

3 Press simultaneously SHIFT + SETUP buttons

4 A menu is displayed, then the screen allows to select Install from 
USB

5 Press the key to confirm

6 In the new screen displayed, you can either:

– Press 1 to add the missing elements or replace the corrupted ones.

The upgrade will start automatically

– Press 2 to delete all and re install all the softwares

a If the button 2 is pressed, the updates available will be 
displayed.

b Use direction keys  to display the available choices and 
install the software versions wished

c Once the choice is selected, press ENTER

The update will start automatically.

NOTE

The software versions list does not always appear (cf previous ver-
sions) as well as the Previous / Next Choice buttons and the Con-
firm/Continue key. In this case, the upgrading starts automatically.

During the upgrade, the Testing indicator is lit in red. Do not 
push any button or remove the USB memory stick while the 
indicator is lit. The USB stick can be removed if necessary once 
the Testing indicator is off.
User Manual 770000002/04 185



Chapter 12 Maintenance
Replacement of the small PCB battery (for backup)
7 Once the upgrade is completed, the 4000 Base Unit will automati-
cally tunrs on and display the Home page.

Replacement of the small PCB battery (for backup)
The 4000 Platform Lithium battery on the microprocessor board ensures 
that date, time and certain information data are not lost when the instru-
ment is switched off.

Checking the
battery

If there is doubt as to whether the battery needs to be changed or not, 
switch off the instrument. On switching the instrument on again, check 
whether the date is still correct. If the date has been lost, the battery 
needs replacing. 

Contact your nearest JDSU Customer Service Centre.

This battery has an average life of more than five years.

Battery replacement should not be carried out by the user:
this may be dangerous to the microprocessor board (certain 

components may be damaged or destroyed) and requires special 
tools

Touchscreen calibration
If the 4000 Platform is equipped with a touchscreen, a specific button 
Touchscreen Calibration appears in the right hand corner of the setup 
screen.

To calibrate the touchscreen

1 Push the HOME button

2 Press the System Settings key

3 Press the Touchscreen Calibration key

The Testing indicator will be lit in red during upgrade. Do not 
push any key or remove the USB memory stick until the lit turns 
off.
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A blue slightly smaller screen appears, displaying a little target on 
the left hand corner . 

4 Click on this target (preferably with the touchscreen pen). 

5 A new target appears then and again for a total of 4 times, in order 
to click on all corners of the screen.

If all the targets are not correctly touched, the touchscreen cannot be 
used. Otherwise, the touchscreen may be used directly.

General information on warranty
The warranties described herein shall apply to all commercially available 
JDSU products. Any additional or different warranties shall apply only if 
agreed to by JDSU in writing. These warranties are not transferable 
without the express written consent of JDSU. 

Hardware
Warranty

JDSU warrants that Hardware Product sold to customer shall, under 
normal use and service, be free from defects in materials and workman-
ship. Information regarding the specific warranty period for this product 
can be obtained by contacting your local JDSU Customer Service Repre-
sentative, or at our web site www.jdsu.com. If installation services have 
been ordered, the warranty period shall begin on the earlier of (1) 
completion of installation, or (2) thirty (30) days after shipment to 
customer. If Installation Services have not been ordered, the warranty 
period shall begin upon shipment to Customer. Hereafter these periods 
of time shall be collectively referred to as the Initial Warranty Period.

Fig. 116 Touchscreen calibration

Target
User Manual 770000002/04 187



Chapter 12 Maintenance
General information on warranty
JDSU ’s obligation and customer’s sole remedy under this Hardware 
Warranty is limited to the repair or replacement, at Acterna’s option, of 
the defective product. JDSU shall have no obligation to remedy any such 
defect if it can be shown: (a) that the Product was altered, repaired, or 
reworked by any party other than JDSU without JDSU’s written consent; 
(b) that such defects were the result of customer’s improper storage, 
mishandling, abuse, or misuse of Product; (c) that such defects were the 
result of customer’s use of Product in conjunction with equipment elec-
tronically or mechanically incompatible or of an inferior quality; or (d) that 
the defect was the result of damage by fire, explosion, power failure, or 
any act of nature.

JDSU performed repairs shall be warranted from defective material and 
workmanship for a period of ninety (90) days, or until the end of the Initial 
Warranty Period, whichever is longer. Risk of loss or damage to Product 
returned to JDSU for repair or replacement shall be borne by customer 
until delivery to JDSU.

Upon delivery of such product, JDSU shall assume the risk of loss or 
damage until that time that the product being repaired or replaced is 
returned and delivered to customer. Customer shall pay all transportation 
costs for equipment or software shipped to JDSU for repair or replace-
ment. JDSU shall pay all transportation costs associated with returning 
repaired or replaced product to customer.

Warranty
disclaimer

For hardware and/or services furnished by JDSU, the foregoing warran-
ties are in lieu of all other warrantees and conditions, express or implied. 
JDSU specifically disclaims all other warranties, either express or 
implied, on any hardware, documentation or services including but not 
limited to warranties relating to quality, performance, noninfringement, 
merchantability or fitness for a particular purpose, as well as those arising 
from any course of dealing, usage or trade practice. under no circum-
stances will JDSU be liable for any indirect or consequential damages 
related to breach of this warranty.
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13

This chapter contains the technical specifications of the MTS/T-BERD 
4000 mainframe.

The topics discussed in this chapter are as follows:

– “Display” on page 190

– “Memory” on page 190

– “Input/Output” on page 190

– “Power supply” on page 190

– “Dimensions - Weight” on page 191

– “Environment” on page 192

– “Characteristics of the options” on page 194
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Display
Display

Screen – Backlight high visibility color screen

– Size: 7 inches 

– Resolution: 800 x 480 pixels

– Standard: high visibility screen for indoor and outdoor use, non-
tactile.

– Options: High visibility touchscreen

Memory
– Standard memory: internal memory, minimum capacity 512 Mb (with 

a minimum of about 32 Mb are available for data storage)

– Options:

- Extension memory 1Gb or higher

Input/Output
– two USB 2.0 Master ports, for printer, mouse, keyboard, memory 

key, camera, optical microscope, etc.

– one RJ 45 connector for Ethernet interface 10/100/1G

– built-in microphone and loudspeaker + headset

Power supply

Battery The instrument can be supplied with one Lithium Ion 6 cells (7400 mV) 
or 9 cells (11100 mV) battery.

Endurance of the MTS/T-BERD 4000 with battery

Measurement conditions:

- at +25 °C, 

- at full battery capacity (6.6 Ah), 

- MTS/T-BERD 4000 equipped with one OTDR LM module
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Endurance

Mains adapters

Supply or Power assigned in AC and in DC: 35 W

Dimensions - Weight

Endurance

Conditions of use
6 cells battery 
(7400 mV)

9 cells battery 
(11100 mV)

According to Telcordia GR-196-CORE recommen-
dation:
Normal conditons, with normal backlight, 3 acqui-
sition of 30 seconds per quarter of hour, auto off

up to 7 hours up to 11 hours.

Under continuous acquisition, with high screen 
backlight 

Up to 3h15 Up to 5h15

Standard Mains Adapter

Input 100-250 V, 50-60 Hz

Output 15V DC 3,7 A max

Compliance EN 60950

Weight

User interface module without options, battery nor module 1.2 kg 2.65 lbs

User interface module with a 6 cells battery, one OTDR LM Module 
and one dummy module

2.2 kg 4.85 lbs

User interface module with a 9 cells battery and one Copper/VDSL 
module

2.3 kg 5.1 lbs

OTDR LM Module 366 g 0.80 lbs

9 cells battery 490 g 1.08 lbs
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Environment

Temperature

Humidity – 5 to 95% without condensation

Climatic
pressure

Climatic pressure: 4000 meters

6 cells battery 344 g 0.76 lbs

Dummy module 208 g 0.46 lbs

VFL/PWM option 26 g 0.06 lbs

Weight

Dimensions (mm)
( H X W X D )
Bumpers included

Dimensions (mm)
( H X W X D )
W/o bumpers

Without module 57.5 x 282 x 153 56.5 x 275 x 129

With 2 small modules 97 x 282 x 153 93 x 275 x 129

 Options not included and modules combined 
dissipation < 10 Watts:

– Operation on mains supply 

– Operation on 9 cells battery, ventilated 
version

 Options not included and modules combined 
dissipation < 6 Watts:

– Operation on mains supply 

– Operation on 9 cells battery, water resis-
tant version

-20°C to +50°C
(-4°F to +122°F)

– Operation including all options (guaranteed 
specifications)

0° to +40°C
(+32°F to +104°F)

– Storage
-20C to +60C
(-4°F to +140°F)
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EMI/ESD – CE class B Compliant (EN61326-1)

– FCC 47-1 Part 15 Compliant

Electrical
Safety

– EN 61010-1: 2001 Compliant

Drop test In accordance with the Telcordia GR-196-CORE recommendations, the 
MTS/T-BERD 4000 resists the following test: 

– 6 impacts dropped from a height of 1m on a pinwood floor of 5 cm 
thickness (1 impact on each of its 6 sides, with power off).

Shocks The MTS/T-BERD 4000 resists the following test:

– 3 shocks per axis along each of the 3 axes, with power off.

– Impacts of 15g, 1/2 sine, duration 11 ms, at 10 second intervals.

Bumps The MTS/T-BERD 4000 resists the following test: 

– 1,000 bumps per axis along each of the 3 axes, with power off.

– Jolts of 15g, 1/2 sine, duration 6 ms, at 1 second intervals.

Vibration The MTS/T-BERD 4000 resists the following vibration tests:

– Complete test comprising 6 cycles along each of the x, y and z axes.

– One cycle of 5 to 200 Hz and back to 5 Hz with a sweep duration of 
one minute/octave.

– 3 mm amplitude displacement test, for the range 5 Hz to 15 Hz.

– 3g acceleration test for the range 16 Hz to 200 Hz.

Flammability The housing of the MTS/T-BERD 4000 (in ABS, type V0) does not propa-
gate fire.

IP Protection
Index

Index of the IP protection for the 4000 Platform: IP32

NOTE

For a higher classification, contact JDSU.
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Characteristics of the options

Power meter
option

Specifications given for 25°C, after 20 minutes stabilization time and after 
zero setting.

– Wavelength range: 800 to 1650 nm in steps of 1 nm

– Calibrated wavelengths: 850 / 1310 / 1550 nm

– Accuracy at calibrated wavelengths: ± 0.2 dB (at -30 dBm)

– Input power range : -60 dBm to +10 dBm

– Maximum resolution: 0.01 dB / 0.01nW

– Measurement range:+5 to -50 dBm (-45 dBm from 800 to 1250 nm)

– Linearity within the measurement range: ± 0.2 dB

High power
Power meter

option

Specifications given for 25°C, after 20 minutes stabilization time and after 
zero setting.

– Wavelength range: 800 to 1650 nm in steps of 1 nm

– Calibrated wavelengths: 850 / 1310 / 1550 nm

– Accuracy at calibrated wavelengths: ± 0.25 dB (at -15 dBm)

– Input power range : +30 dBm to -40 dBm

– Measurement range:+27 to -30 dBm

– Linearity within the measurement range: ± 0.25 dB

VFL – Wavelength: 635 nm or 650 nm

– Length of fiber: up to 5 km

– Class 2 laser (standards EN60825-1 and FDA21 CFR Part 
1040.10).

WIFI and
Bluetooth

Options

– WIFI:standard  IEEE802.11b/g

– Bluetooth Option

– Class 2

– Range: up to 10 meters
194 User Manual 770000002/04



Chapter 14 Options and accessories
14

This chapter shows the references of the options and accessories of the 
4000 Platform.

The topics discussed in this chapter are as follows:

– “References of options for the 4000 Platform mainframe” on 
page 196

– “Reference of Scope” on page 197

– “References of accessories” on page 198

– “References of manuals” on page 198

– “References of result processing software” on page 199
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References of options for the 4000 Platform mainframe1

1.These options must be ordered together with the instrument.

Base Unit references Reference

MTS-4000 Fiber Platforma M4000SP

T-BERD 4000 Fiber Platforma TB4000SP

MTS-4000 Fiber/Copper Platformb M4000

T-BERD 4000 Fiber/Copper Platformb TB4000

MTS-4000 Fiber/Copper Platform with touchscreenb M4000T

T-BERD 4000 Fiber/Copper with touchscreenb TB4000T

MTS-4000 Fiber/Copper/inHome Platform with touchscreenb M4000HPT

T-BERD 4000 Fiber/Copper/inHome Platform with touchscreenb TB4000HPT

a. Delivered with a 6 cells battery
b. Delivered with a 9 cells battery

Base Unit options Reference

Backplane for 4000 Platform 40BACKP

Memory options Reference

Extended internal Memory 40EXTMEM

Power Meter / VFL / Wifi / Bluetooth options Reference

Optical Power Meter with 2.5 mm UPP connector 40PM

High Power Power meter with universal UPP 2.5MM adapter for 4000 Platform 40HPPM

VFL with UPP connector 40VFL

Optical Power Meter and VFL, with 2.5 mm UPP connectors 40PMVFL

Wifi/Bluetooth Interface 40WIFIBLU
196 User Manual 770000002/04



Chapter 14 Options and accessories
Reference of Scope
Reference of Scope

Battery options Reference

Additional Li-Ion rechargeable battery LIION9C

Mains options Reference

Additional standard AC/DC adapter/charger  (USA) 40PWUS

Additional standard AC/DC adapter/charger (UK) 40PWUK

Additional standard AC/DC adapter/charger (Europe) 40PWE

Additional standard AC/DC adapter/charger  (Australia) 40PWAU

Additional standard AC/DC adapter/charger  (Switzerland) 40PWCH

Additional standard AC/DC adapter/charger  (India/South Africa) 40PWIN

Additional standard AC/DC adapter/charger  (Italy) 40PWIT

Additional standard AC/DC adapter/charger  (Israel) 40PWIL

Additional standard AC/DC adapter/charger  (Japan) 40PWJP

Additional standard AC/DC adapter/charger  (Denmark) 40PWDK

Cigarette lighter adapter for 4000 Platform 40Lighter

Reference

Quick Capture Video Microscope, 200x/400x with USB converter, 
includes FC, SC, SC-APC, LC, U25M, U25MA & U12M tips, Soft Case

EFSCOPE400

Digital Videoscope kit including FBP-P5000 probe (USB2.0) in a small 
soft case, and 7 tips in a box (FBPT-FC, FBPT-LC, FBPT-SC, FBPT-
SC-APC, FBPT-U12M, FBPT-U25M, FBPT-U25MA)

EDFSCOPE5K
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References of accessories
References of accessories

References of manuals

Carrying Cases References

Large Soft case for MTS/T-BERD 4000 modules 40LMODSCASE1

Soft case for small MTS/T-BERD 4000 modules 40SMODSCASE1

Hard carrying case for the MTS/T-BERD 4000 and various accessories EHCASE6

Glove Soft Case for MTS/T-BERD 4000 Platform 40GLOVE

Wrap-around Soft Case for MTS/T-BERD 4000 Platform 40SCASE1

Straps

Handstrap for MTS/T-BERD 4000 Platform 40HANDSTRAP1

Hookstrap for MTS/T-BERD 4000 Platform 40HOOKSTRAP1

Keyboard/Mouse Reference

USB mouse E80mouse

USB QWERTY keyboard E80keyB

User manual for 4000 Platform Reference

Printed User manual for 4000 Platform platform (French) E4000M01

Printed User manual for 4000 Platform platform (English) E4000M02

Printed User manual for 4000 Platform platform (German) E4000M03

4000 Platform user manual (USB stick) E4000MUSB

NOTE

The USB key countaining all the user manuals (Base and Module) is 
delivered on standard with the Platform.

The printed versions of the manuals are available on option, in 
French, English and German.
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References of result processing software2

2.Free software updates on the Web (but without user manual)

Reference

Optical Fiber Trace software EOFS100

Optical Fiber Trace software (5 licences) EOFS1005L

Optical Fiber Trace software (site licence) EOFS100SL

FiberTrace software - update EOFS100UP

Optical Fiber Cable software EOFS200

Optical Fiber Cable software (5 licences) EOFS2005L

Optical Fiber Cable software (site licence) EOFS200SL
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Application
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eMail 102
VNC Viewer 87
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Automatic shutdown 54

B
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charging time 15
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safety instructions 3
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file export 117
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C
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optical connectors 179
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Configuration
principle 44
unit 47

Connectors 41
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Control Interface 24

Controls
buttons 26
external keyboard 29
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D
Date 51

Direction keys 28

Directory
edition 168
remove 169
selection 167

E
Editing 31

eMail 102
Account page 103
advanced parameters 109
basic parameters 103
compose parameters 108
composing 111
receive parameters 105
send parameters 107
template parameters 108

Environment 192

Ethernet
LAN parameters 52
TE mode testing 132
Web browser 141

accessing 141
adding/deleting bookmarks 
145
bookmarks selection 144
exiting 145
navigating 142
opening a web page 143

Event log 129

F
File

configuration 164
merge 173
selection 171
sending 174
sending by bluetooth 175
sort 173
storage media 164
types 170

File explorer 114
description 164

G
Guarantee conditions 178

H
Hands-free 54

Headset 54

Help page 46

High power Powermeter 194

Home page 45

HTML file 170

I
I/O Interface 51

Indicators 28

Interface
transfer onto a PC 37

J
JPG,JPEG file 171

Jumper reference 71

K
Keyboard & Mouse

reference 198

L
Language 51

Laser 2
License

enter manually 59
import from USB 60

License file 59, 170

M
Mail
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configuration 53
sending 174

Maintenance
procedure 178

Measurement
attenuation measurement 66
optical link loss 66
power measurement 66

Memory
capacity 190
see File

Module
fitting and removing 10

MSOR file 170

N
Network place 40

O
Optical connectors

precautions 179

OSA file 170

OTDR file 170

P
P5000 Microscope 154

Patents 21, 47

PCB Battery
checking 186
replacement 186

PDF File 170

PDF viewer 78

Platform
access to the internal memory 38
access to the USB stick 38
architecture 5
assembly 10
automatic shutdown 54
configuration 44
connection to a PC 35
dimensions 192
direction keys 28
front panel 24

indicators 28
locking 63
numeric keypad 27
position 12
references 196
reset 20
switching off 19
switching on 18
troubleshooting 21
upper panel 42
user interface 5
weight 191

Power meter
alarm 69
attenuator compensation 68
configuration 67
connection 67
file management 73
measurement 71, 72
reference 196
reference measurement 72
results 69
specifications 194
zero value 72

Power Meter file 170

Presentation screen 20

Printer 55

Processing software
reference 199

R
Remote screen 51

Results
event log 129

S
Scope

display 149
feature 148
file toolbar 154
freeze 150
load picture 152
luminosity & contrast 149
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reference 197
save picture 151

Screen
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specifications 190
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Software update
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via USB 183

Specifications 189

Standalone results 58

Storage media 164
abbreviations 167

T
Text Editor 85

Text file 170

Time 51

Touchscreen
calibration 186
MTS/T-BERD 4000 with 196

U
Unpacking the instrument 10

Upgrade
configuration 54

USB
connection 165
disconnection 166
formating 61, 165
upgrade via 183

User Interface 5
User manual

reference 198

V
Validate a function 45

VFL
connection 67
emission of light 73
function 73
mode 54
reference 196
specifications 194

Video file 171

Visible source (VFL)
connector localization 42

VNC Viewer 87

W
Web Browser

access 80
bookmarks 83
navigation 82
pdf document 84
proxies 82
quit 85

Web browser 141

WIFI
standard 194

Wireless
BBS properties 124
errors 126
frame results 127
network with range 128
run test 120
setting parameters 120
summary results 122

Wireshark 112

X
XML file 171
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